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1.  Introduction

DocuTag works with the Elixir PrintDriver, ElixiForm,
HP2XRX, and VP297 programs to bring the power of
WYSIWYG (What You See Is What You Get) form
and document creation to users of Image Sciences'
DocuMerge.

Overview

This section provides a brief overview of DocuTag, the
products supported with DocuTag, and describes
what you need to know to use DocuTag successfully.

Image Sciences' DocuMerge

You must understand DocuMerge before using Docu-
Tag.  DocuMerge is a product that provides sophisti-
cated variable data merging and document assembly
capabilities to mainframe/host environments.

DocuMerge identifies variable data areas within docu-
ments by using BoilerPlate Space Definition (BPSD)
tags.  DocuMerge uses BPSD tags to recognize vari-
able data placement in a document.  Single- or multi-
page forms are stored in composed format in a Docu-
Merge Electronic Document Library (EDL).

DocuTag overview

DocuTag converts Windows-based documents using
ElixiForm or one of Elixir's datastream conversion
packages (like the Elixir PrintDriver, HP2XRX, and
VP297) into DocuMerge normalized metacode files,
complete with BPSD tags.  
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These files are loaded into a DocuMerge EDL.  Once
stored in an EDL, they can be merged with variable
data and sent to Xerox printing systems.

DocuTag also converts existing normalized metacode
files created by IBM Document Conversion
Facility/Plus (DCF+) to Elixir's internal .ELX format
and then loads them into ElixiForm.  In ElixiForm, sin-
gle or multi-page documents (one page at a time) can
be easily modified.  Once a normalized metacode
EDL member is imported into ElixiForm, the member
is editable, including the attributes assigned to each
BPSD tag.

Other features of DocuTag

DocuTag allows you to:

IMPORT existing normalized metacode files into
ElixiForm for WYSIWYG editing (when used with
IBM 3270, IRMA FT/3270, or IRMA FT/SO file
transfer packages)

eliminate the need to buy expensive host
computer-based composition systems like IBM's
Document Composition Facility

reduce training and maintenance costs by replac-
ing non-interactive, code-intensive document de-
velopment environments with WYSIWYG
packages including ElixiForm and Windows-
based applications.  (see "Supported Windows
applications")

eliminate CPU charges and expensive mainte-
nance incurred by host computer composition
systems

eliminate connect-time charges associated with
3270 terminal operation

proof-print documents using inexpensive desktop
printers attached to personal computers

reduce document development time by taking ad-
vantage of the simplicity of WYSIWYG document
creation and editing.   

INTRODUCTION
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Supported Windows applications

DocuTag and the Elixir PrintDriver were tested with
the following applications:

- Word for Windows 2.0

- Word for Windows 6.0

- WordPerfect for Windows 5.2

- WordPerfect for Windows 6.0 

- Corel Ventura Publisher 4.2

- Ami Pro for Windows 3.0

- Aldus PageMaker 5.0

Using the Elixir PrintDriver and DocuTag

Using the Elixir PrintDriver and DocuTag, you can
convert a Windows-based document into a normal-
ized metacode file directly from a Windows application
menu.

You install the PrintDriver as one of the standard Print
Drivers in Windows, compose a document in a
Windows-based documentation package, add BPSD
tags using ElixiTag, and select the print option.

The Elixir PrintDriver generates the normalized meta-
code file and saves each resource in a separate direc-
tory providing easy access for editing and proofing.

Using DocuTag with ElixiForm

ElixiForm is a Windows-based, interactive WYSIWYG
program that supports all Xerox printers.  It is used for
forms creation, maintenance, and conversion.  Elixi-
Form allows you to create and edit forms with lines,
boxes, text, and graphics, for use within DocuMerge.

INTRODUCTION
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In addition, you can fully define BPSD tags, add them
to a form, and edit them within ElixiForm.

After a form is complete, DocuTag converts the Elixir
form file into normalized metacode format.  You then
upload the file to the host computer, convert it to a
VBM format file, and add it to the DocuMerge Elec-
tronic Document Library (EDL) using VLMUTIL or
VLMMAINT LOAD utilities.  For further details, see the
"Transferring files to the host" chapter.

Note:  DocuTag is intended for use in MVS host envi-
ronments.  If you are attempting to use DocuTag in a
non-MVS environment, you must determine the proce-
dures for uploading normalized metacode files from
the PC to the host, converting them to VBM format,
and storing them in an EDL.

Using DocuTag with VP297 or HP2XRX

You can also convert documents post-processed by
VP297 or HP2XRX into normalized metacode format.
VP297/HP2XRX automatically generates a form list
that tells DocuTag the names of the Elixir form files
corresponding to each page of the original Windows-
based document.  Form lists allow DocuTag to handle
multi-page documents and permit you to define cus-
tom sequences of pages for conversion to a single
normalized metacode file.

You can specify BPSD tag attributes in ElixiForm after
the document has been processed by
VP297/HP2XRX.  You can also specify tag replace-
ments used with an external tag file.

After VP297/HP2XRX converts a document to a se-
ries of Elixir form files, the form files can be converted
into a normalized metacode EDL member. The nor-
malized metacode file produced can then be uploaded
to the host computer and added to the DocuMerge
EDL using the VLMUTIL or VLMMAINT LOAD utilities.
For further details, see the chapters in this guide re-
lated to using VP297 and HP2XRX with DocuTag.  

INTRODUCTION
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Task planning

The following provides an example of task planning
for using DocuTag to create and upload normalized
AFPDS files to the host.  

Task Reference(s)

Decide what resources you need Fonts, images, and forms

Download the resources Elixir Desktop User Guide

Convert the resources to Elixir
format

Elixir Desktop User Guide

Create fonts or images ElixiFont User Guide, 
ElixiGraphics User Guide

Create forms ElixiForm User Guide

Incorporate data tags in a form The "Elixir PrintDriver and Docu-
Tag" and "ElixiForm and Docu-
Tag" chapters

Create a .DAT file The "Converting files with the
Desktop" section of the "Elixi-
Form and DocuTag" chapter

Convert  .DAT  to .NOR The "Converting files with the
Desktop" section of the "Elixi-
Form and DocuTag" chapter

INTRODUCTION
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Customer support

If you have purchased your Elixir product directly from
Elixir Technologies then contact the support center for
your region at the number listed below.

North and South America: 
+1  805 641 5900 ext. 3

Asia Pacific 
+92 (0) 51 206182

Europe  
+420 2 2431 13877

The U.S.A. Elixir Customer Support Center provides
telephone technical assistance for Elixir users Monday
through Friday from 6:30 a.m. to 5:00 p.m.  Pacific
Standard Time.

If you have any problems running or using Elixir Print-
Driver or associated Elixir applications, contact the
support center in your region for help.  An Elixir prod-
uct specialist will answer your call and ask for the fol-
lowing information:

your name, organization, telephone number and
address.

the name and version number of the Elixir
application.

a complete description of the problem, including
any error messages displayed on your monitor or
printed at your printer.

You can contact Elixir support  by accessing the Elixir
World Wide Web page (and selecting [Contact Sup-
port]) at http://www.elixir.com.  Please complete the
question form.

INTRODUCTION
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Elixir Web site support

The Elixir Web site at http://www.elixir.com offers the
following resources:

Raise a question for Elixir Support.

Find answers in the list of Frequently Asked
Questions.

Review the latest Tips and Techniques for in-
creasing productivity using Elixir software.

Download new releases and the latest patches.

View Release Notes for the latest available
features.

Learn in the user newsgroup how others are us-
ing Elixir products.

Sign up for an Elixir Learning Program.

    Elixir training

Elixir Technologies Corporation offers training for the
full range of our Windows-based family of products.
For more information, contact:

     Elixir Learning
(805) 641-5900  ext. 6

INTRODUCTION
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Who should use this guide

To use DocuTag effectively, you should have the fol-
lowing background:

familiarity with DocuMerge, DOS, and Windows

an understanding of the products you will be us-
ing to create files for DocuTag, including Elixi-
Form, the Elixir PrintDriver, HP2XRX, VP297, and
your Windows-based application

experience with your PC-to-mainframe file trans-
fer package and an understanding of how to
transfer files in transparency or binary mode
(without ASCII to EBCDIC translation)

knowledge of DocuMerge utilities such as VLMU-
TIL and VLMAINT

an understanding of the JSL, JDE, and DJDE pre-
fix used on your printer to print DocuMerge
documents

knowledge of MVS JCL and familiarity with the
IEBGENER and IEBCOPY utilities.

If you are lacking expertise in any of these areas,
please secure assistance from experienced personnel
within your organization.  Having personnel on hand
who have an understanding of each of these compo-
nents will make it easier for you to use DocuTag
effectively.

Conventions

Most of the following conventions are the same or
similar to Windows conventions.

display conventions

typographical conventions

mouse operations

INTRODUCTION
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Display conventions

The Elixir Desktop, ElixirForm, ElixirFont and Elix-
irImage all adhere to Microsoft Windows conventions
for using menus, menu commands, dialog boxes,
command buttons, icons and mouse.  See your Win-
dows manual for more information.

Typographical conventions

The following typographical conventions are used
throughout this guide and other Elixir product guides.

Keystrokes are shown enclosed in < > (angle
brackets). For example:  

<Enter>

Key combinations are denoted by a plus sign be-
tween keys. For example: 

<Shift> + <F1> indicates to simultaneously press
the <Shift> and the <F1> keys.

Menu titles are shown in bold. Menu options are
enclosed in [ ] (square brackets). For example:

Select [New] from the File menu.

Commands, options, actions, and parameters
that require description are shown in bold fol-
lowed on the next line by the description.  For ex-
ample:

Delete
Deletes the selected files.

Steps in a procedure are shown in numbered bold
paragraphs.  For example:

1. At the prompt, enter the file name and
extension.

Comments relating to a step (such as this para-
graph) are shown in regular text following the bold
paragraph.

INTRODUCTION
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Commands you enter at the DOS prompt are
shown in larger text.  Within DOS commands,
variable names and keys you press are shown in
italics.  For example: 

CD \ELIXIR <Enter> 

Mouse operations

You can perform most operations in Elixir applications
by using the mouse.  The terminology is similar to
other Windows based applications.

Mouse operations are performed using the left or right
mouse buttons, depending on the specific task.

The following mouse related terms are used in this
guide:

click
to momentarily press and release the left mouse but-
ton once.  A right mouse button click is specified
where necessary.  For example,

Click on the right mouse button to finish entering text.

double-click
to click the left mouse button twice in rapid
succession.

drag
to click and hold the mouse on an item and move the
item with the mouse.

drag and drop
to drag an item as above, then release the mouse but-
ton, once the item is positioned over a the area.  If the
selected object is a file and the destination is a direc-
tory, the file copies to the directory.

object
a selectable item on the screen.

open
to point and double-click on an icon -- the effect of this
operation depends on the icon.

INTRODUCTION
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point
to move the mouse to position the screen pointer on
an area of the screen.

select
to point to an object and click the mouse -- this usually
highlights the object.

<Alt>click
to hold down the <Alt> key while pressing the left
mouse button -- this allows you to select a range of
files in a window.

<Ctrl>click
to hold down the <Ctrl> key while pressing the left
mouse button -- this allows you to select individual
files from a group in a window.

<Shift>click
to hold down the <Shift> key while clicking the mouse
-- this allows you to select more than one object at a
time. 

On-line Help

Elixir software uses the Microsoft Windows Help pro-
gram to provide on-line Help for all functions.

For more information about Windows Help, select the
[How to Use Help] option in the Help menu, or see
your Microsoft Windows documentation.

The Help files included with your Elixir software in-
clude graphics created using screen drivers with large
fonts.  If you use a screen driver with small fonts, the
Help file graphics may not display clearly.  For opti-
mum graphics display, use a screen driver with large
fonts.

You can display on-line Help in the following ways:

INTRODUCTION
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Bubble Help
Click on an icon with the right mouse button to view its
properties (if applicable) or to display "bubble help."
Bubble help is a short description of the icon function
that displays in a bubble extending from the icon.  

Quick Help
Enable the quick function by selecting the quick help
option in the Usage Switches (or Preferences -- for
ElixirImage) dialog box.  When you move the screen
pointer over an icon on the screen, a short description
of the icon function displays in the message area of
the screen.  During certain operations a message
about the function you are performing also displays in
the message area.  To see these operational mes-
sages, disable quick help.

Context sensitive Help
To use this function, click on an icon and press <F1>.
If available, the appropriate Help topic displays.  If no
specific topic is available, the Help table of contents
displays.

Help menu
Select [Help] from the top pull-down menu and choose
one of the displayed topics.

Dialog box Help
Click on the [Help] button in a dialog box to view an
associated Help topic.  Under Windows 95 and Win-
dows NT, right-click on a dialog box option to display
an associated Help topic.

Help pop-ups and jumps
Within Help topic text, words or phrases underlined in
green are pop-ups or jumps.  When you click on a
pop-up topic, a box displays within the current Help
topic with additional information.  When you click on a
jump, a different, associated Help topic displays.

INTRODUCTION
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Help hypergraphics
Hypergraphics are special graphics within Help files
that contain "hot spots".  Hot spots are either pop-up
topics or jumps. Hypergraphics in Elixir Help are most
commonly dialog boxes with option hot spots (pop-up
definitions), toolboxes with tool hot spots (topic
jumps), and menus with option hot spots (topic jumps
or pop-up definitions).  

Move the cursor over a hypergraphic until a hand dis-
plays, then click on this hot spot to display a pop-up
topic, or a "jump".  To close a pop-up topic, click the
mouse button.  To return to the original Help topic
from a jump, click on <Back> in the Help file menu. 

Using Online documentation

This section describes how to use PDF online docu-
mentation, including navigating through the online
guides and printing the guides.  Acrobat Reader is
provided with the online documentation.  Information
about using the Acrobat Exchange program is in-
cluded for users who have licenses for that program.

Accessing online guides

The PDF online documentation is copied to the
drive:\Elixir\help\pdf directory during the installation.  If
you didn't choose to copy the PDF online documenta-
tion during the installation, you can view a complete
list of the files by clicking on the Windows [Start] but-
ton and selecting Programs>Elixir Applications>Elixir
PrintDriver for AFP.  Once the application is launched,
click on the Help menu and select Release Notes.
Wordpad displays a current list of supporting docu-
ments and the directories where they can be found on
CD-ROM.

When the appropriate PDF file is accessed the Acro-
bat Reader program is launched and the List of Online
Guides is displayed.  Click on a guide to view its table
of contents and jump to individual chapters. 

INTRODUCTION
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The following list of PDF files and associated docu-
ment names are installed in the drive:\Elixir\help\pdf
directory.

StartAFP.pdf - AFP Getting Started Guide

StartXRX.pdf - Getting Started User Guide

DeskAFP.pdf - Elixir Desktop and Converters for
AFP User Guide

DeskXRX.pdf - ElixiSys Desktop User Guide

FormAFP.pdf - ElixirForm User Guide

FormXRX.pdf - ElixiForm User Guide

FontAFP.pdf - ElixirFont User Guide

FontXRX.pdf - ElixiFont User Guide

ImageAFP.pdf - ElixirImage User Guide

GraphXRX.pdf - ElixiGraphics User Guide

PdAFP.pdf - Elixir PrintDriver for AFP User Guide

PDXRX.pdf - Elixir PrintDriver User Guide

PdNT.pdf - Elixir PrintDriver for NT User Guide

PHXRX.pdf - PageHandler User Guide

DTAG.pdf - DocuTag User Guide

DMerge.pdf - DataMerge User Guide

AppVIPP.pdf - Elixir AppBuilder for VIPP User
Guide

AppAFP.pdf - Elixir AppBuilder for AFP User
Guide

Transfmr.pdf - Elixir Transformer Suite User
Guide

INTRODUCTION
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Viewer.pdf - ElixirViewer User Guide

Elxscan.pdf - ElixiScan User Guide

Navigating in online guides

After loading a PDF document in Acrobat Reader or
Exchange program (as described above), you can
navigate through the online guide by clicking on the
following:  

TOC chapter titles - jumps to the beginning of the
chapter indicated.

[Next Page] or [Previous Page] in the Toolbar - jumps
to the next or previous page of the online guide (alter-
natively, you can use the <Page Up> and <Page
Down> keys).

[Go Back] in the Toolbar - returns to your previous
location.

[First Page] in the Toolbar - returns to the opening
screen of the online guide.

Word find

This option finds a key word or phrase in the current
document.

To use Word Find in a document:

1. Click on the [Find] icon in the Toolbar.

2. Enter the desired search text and click on
[Find].

The Acrobat Find dialog box closes and the first
occurrence of the text is highlighted.

3. To find more occurrences of the same text,
click on the [Find] icon in the Toolbar and
then click on [Find Again] in the Find dialog
box.

INTRODUCTION
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Page scrolling

You can move a document on the screen to view por-
tions of it not visible in the window, or read a docu-
ment which contains article threads by clicking the
mouse to scroll through the document without using
the scroll bar.

To move a document on the screen for viewing (func-
tional only when the document displays wider than the
document window):

1. Click on the [Hand] icon in the Toolbar.

2. Hold down the mouse button and drag the
cursor in the desired direction.

To follow the flow of text in a document that contains
article threads (automatic text flows):

1. Click on the [Hand] icon in the Toolbar.

2. If the document contains article threads, a
“down” arrow displays on the Hand icon.

3. Position the hand-shaped cursor over a
paragraph and click on the paragraph to begin
reading. 

4. Continue clicking to follow the flow of text.

Zoom in/out

To magnify the size of the page display, click on the
Zoom icon in the Toolbar, then click in the Work area.
Each click resizes the view by a factor of two.

To reduce the size of the page display, click on the
Zoom icon in the Toolbar, then hold down the <Ctrl>
key and click in the Work area. 

You can also click on the [%] button at the bottom of
the screen and select a zoom percentage from the
pop-up list.
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Printing online guides

You can print individual chapters or an entire book to
PostScript or HP printers:

1. Open the file.

2. Select File>Print.

The Print dialog box displays.

3. Select your printing options and click on [OK].

Organization of this manual

This user guide contains the following chapters and
appendices:

Chapter 1, "Introduction," provides an introduction to
DocuTag and describes the contents of this user
guide.

Chapter 2, "System requirements and installation," de-
scribes PC hardware and software requirements and
how to install the DocuTag software.

Chapter 3, "The Elixir PrintDriver and DocuTag," de-
scribes how use ElixiTag and the Elixir PrintDriver to
create BPSD tags and how to convert documents to
normalized metacode files while in your Windows-
based application.

Chapter 4, "ElixiForm and DocuTag," describes how
to create a document in ElixiForm, add and edit BPSD
tags, and convert the ElixiForm file into a normalized
metacode file.

Chapter 5, "VP297 and DocuTag," describes how to
use VP297 to add BPSD tags and post-process Ven-
tura Publisher .C00 documents into Elixir form files.

Chapter 6, "HP2XRX and DocuTag," describes how to
use HP2XRX to add BPSD tags and post-process .HP
documents into Elixir form files.
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Chapter 7, "Transferring files to the host," describes
how to upload files from your PC to a host environ-
ment for processing and subsequent delivery to a
DocuMerge EDL.

Chapter 8, "Extracting files from the host," describes
how to download files from an EDL to the Desktop us-
ing the Desktop converter or the MET2ELX utility.

Appendix A, "Transferring font files between the host
and PC," describes how to use the different transfer
packages to convert fonts before converting files to
the Elixir format.

Appendix B, "VP297 and HP2XRX compatibility," con-
tains information about upgrading to the PrintDriver for
VP297 and HP2XRX users.

Glossary.

Index.  

Notes and cautions

This section describes limitations and considerations
for DocuTag.

The BWCC.DLL file

The existence of a BWCC.DLL file in a directory other
than \WINDOWS\SYSTEM may cause errors when
performing operations such as copying files from the
User files icon to Elixir folders.  Elixir installs a
BWCC.DLL file dated 1993 or later in your \WIN-
DOWS\SYSTEM directory during installation.  Other
programs may also install BWCC.DLL files in different
directories.  Remove these other versions of the
BWCC.DLL file from your system to prevent errors.
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Forms created in previous ElixiForm versions 

ElixiForm 3.0 allows you to use forms created in previ-
ous versions.  However, forms created in ElixiForm
3.0 cannot be used in previous versions of ElixiForm.

If you are using forms in ElixiForm 3.0 that were cre-
ated in a previous version of ElixiForm, screen fonts
generated under the GEM environment may exhibit
some quality loss in the Windows environment.  To
correct this, reconvert the screen fonts.

Elixir's TAP2DSK utility 

Elixir's TAP2DSK utility does not support the importa-
tion of normalized metacode.  If you want to import
normalized metacode using a tape drive, you can do
so using a program such as DEPOT (Data Exchange
Program with Optional Translation) which is included
in the Overland 2.3 software provided with the Over-
land TX-8 controller card.  Please see your Overland
manual for more details regarding this program.

Editability of existing normalized metacode files

After a document is composed into normalized meta-
code format for use within DocuMerge, some text
block integrity may be lost.  What displays on the page
as a single line of text may actually consist of a series
of individual text strings, making editing of the entire
text line somewhat difficult.

For this reason, we strongly recommend that when
creating normalized metacode documents with the
Elixir family of products, you save a copy of the origi-
nal Elixir form file that represents the source form of
the document.

Note:  The Join Text feature in ElixiForm allows you to
rejoin individual text strings into a single paragraph
(See the ElixiForm User Guide).
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ElixiForm multi-page support 

ElixiForm does not directly support multi-page docu-
ments.  To edit multiple Elixir form files generated
from a single multi-page document, each Elixir form
file must be loaded separately into ElixiForm.
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2.  System requirements 
and installation

This chapter provides information on hardware and
software requirements, tape drive considerations, and
installation.

Hardware and software requirements

The following section describes hardware and soft-
ware requirements for running DocuTag.

Hardware

Recommended PC configuration: Pentium (or
100% compatible), with at least 133 MHz processor
(or the fastest commercially available processor); 32
MB RAM, 500+ MB hard drive, one CD-ROM drive.

Additional requirements:  

any monitor with driver software supporting Win-
dows in VGA or SVGA 

any Windows-compatible mouse.

Optional requirements

One of the following for communicating with
Xerox printers:

any PC-to-mainframe or communications
board that supports binary file transfers (such
as IBM PC3270, IRMA FT/3270, or AS/400
PC communications packages)
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any 9-track, 1600 or 6250 bpi tape drive
(such as the Qualstar with the Overland TX-8
controller card).

One or more of the following peripheral devices:

Xerox production printer

HP LaserJet IV or compatible PCL 4 printer
(HP PCL 4 is the format supported), or Post-
Script compatible

CD-ROM Player

Software

Software requirements: Microsoft Windows 95, Win-
dows 98, or Windows NT 4.0 or later. 

While we make every effort to ensure the proper op-
eration of our software, some problems cannot be re-
solved due to differences in the operating systems.

Tape drive configuration

If you use a Qualstar tape unit, copy the
TAPE_MT0.SYS file (and, if provided, the
LDIMG.EXE file) from the driver diskette supplied by
Qualstar to your root directory.

add the following line to your CONFIG.SYS file:

DEVICE= TAPE_MT0.SYS 8

if LDIMG.EXE is included on the Qualstar driver
diskette, add the following command to your
AUTOEXEC.BAT file:

LDIMG 
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to access Elixir stand-alone utilities from any DOS
subdirectory, add \ELIXIR or your ElixiSys custom
directory selected at installation, to the PATH=
statement in your AUTOEXEC.BAT file.  

For example, if your AUTOEXEC.BAT file con-
tains the following line:

PATH=C:\;C:\DOS;D:\UTILS

Modify the PATH= statement as follows:

PATH=C:\;C:\DOS;D:\UTILS;drive:\ELIXIR

drive:
is the hard disk drive on which you install Elixir
DocuTag (see the "Installing DocuTag on your
PC" section in this chapter)

Use any text editor in non-document mode (to gener-
ate ASCII text) to add text to the CONFIG.SYS and
AUTOEXEC.BAT files.  Note that you must reboot
your PC for any changes in your CONFIG.SYS and
AUTOEXEC.BAT files to take effect.

Before installation

Complete the software licensing process (See the
"Product Registration" section).

If you plan to use DocuTag with any other Elixir
products, make sure you know the drive on which
they are installed.  This is the drive where you
must install the DocuTag program.

To avoid any possible conflicts, exit all other ap-
plications before installation.

You may want to make a backup copy of your
diskettes prior to installation.  

SYSTEM REQUIREMENTS AND INSTALLATION
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Release notes

Release notes appear at the beginning of the Elixir
software install process, so that you can review each
entry before performing the complete installation.
Once the software is installed, release notes can be
accessed from the Help menu of the application.  Re-
lease notes are formatted for viewing in Notepad or
Wordpad.  They have a txt file extension and are
found in the drive:\ELIXIR \RELNOTES directory.

Product Registration

Elixir products no longer require ElixiKey hardware de-
vices attached to your parallel port.  Elixir products
now utilize soft key technology.  This new licensing
process validates your license agreement with Elixir
and places a file (password.epw if an Elixir customer,
or License.dat if a Xerox customer) on your
workstation.

Version 4.00 implements Elixir's new licensing proc-
ess and discontinues use of the current hard keys.  All
customers must register/re-register software licen-
se(s) by using the Elixir registration program provided
with the software. 

Each product installed is assigned to a specific pc.
This pc number, your customer number, and pass-
word are required.  This information is provided when
you purchase Elixir software or when you upgrade to
version 4.00 of Elixir products.

If you are an Elixir customer, registration can be com-
pleted automatically if you have an internet connection
on your workstation.  If you are a Xerox customer you
must contact Xerox to register your products.

This section describes the registration process for
those customers who have purchased their Elixir
products form Elixir Technologies.
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The following scenarios describe the  registration
process for Elixir  customers.  Xerox Corporation will
provide a separate document that describes  register-
ing your products with Xerox.

you are a new customer and will use Soft Key
registration

you are an existing customer and will change to
Soft Key registration 

Elixir Product Registration screen

Make your selections according to your needs and go
to the appropriate section for further procedures.

Figure 2-1.  Elixir Product Registration screen

Using the internet 

You can register and download all registration files via
the Elixir Product Registration program.  There are
two ways to register your products using  the Internet:

down load the product registration file directly to
the Elixir PC via the Internet (see "Registering as
a new customer via the internet")
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download the product registration file to another
machine and move it to the Elixir PC (see "Down-
loading via the internet to a non-Elixir PC")

Registering as a new customer via the internet 

You will receive a "Customer Activation Letter" with
your product(s) ordered.  The registration process
should be completed before installing your software.
The installation CD will launch and install the Registra-
tion Program. 

To install the registration program on your Elixir PC: 

1. In the Software Registration screen, click on
[Next].

2. Select the drive and click on [Next].

3. In the Start Registration Process screen, click
on [Install].

The password file will be installed and your sys-
tem configured.

To complete registration:

1. In the Elixir Product Registration "Welcome"
screen, select [Next].

Your machine serial number displays.

2. Enter your customer number (from Activation
Letter), then click on [Next].

3. Enter your password and the PC number you
want to register, then click on [Next]. 

4. Select [Prepare and download my initial
product license registration.  This workstation
or another pc is connected to the internet]
from the Registration Option menu, then click
on [Next]. 

5. In the Download Password screen, click on
[Yes].  
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The system displays your customer information
and you must verify that it is correct.

6. When the screen displays the registration
information, click on [Save].  You may also
print this screen for reference or to send to
Elixir.

The application installation process will begin, see the
"Installation" section.

Downloading via the internet to a non-Elixir PC  

You will receive a "Customer Activation Letter" with
your product(s) ordered.  The registration process
should be completed before installing your software.
The installation CD will launch and install the Registra-
tion Program. 

To install the registration program on your Elixir PC: 

1. In the Software Registration screen, click on
[Next].

2. Select the drive and click on [Next].

3. In the Start Registration Process screen, click
on [Install].

The password file will be installed and your sys-
tem configured.

To complete registration:

1. In the Elixir Product Registration "Welcome"
screen, select [Next].

Your machine serial number displays.

2. Enter your customer number (from Activation
Letter), then click on [Next].

3. Enter your password and the PC number you
want to register, then click on [Next]. 
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4. Select [Prepare and download my initial
product license registration.  This workstation
or another pc is connected to the internet]
from the Registration Option menu, then click
on [Next]. 

5. In the Download Password screen, click on
[No].  

6. In the How to Contact Elixir screen, click on
[Print] and take the printout to the pc
connected to the internet.

7. Access the Elixir Web site at
http:\\www.elixir.com. and click on [Product
Registration].

8. In the Customer Information screen, enter
your Customer Number and Password, then
click on [Submit Form].

9. In the Elixir Customer Menu, click on
[Download a New License File].

10. In the Customer Information screen, enter
your PC Number and Machine Serial Number,
then click on [Submit Form].

11. In the Elixir Technologies screen, click on
[Click here to download your password].

12. Save the password.epw file to diskette and
copy it to your Elixir PC in the \ELIXIR
directory. 

The application installation process will begin, see the
"Installation" section.

Contacting Elixir (no internet connection) 

If you have no internet access at your site you must
contact Elixir and provide the serial number of the pc
where you will install the Elixir software.  Elixir will pro-
vide a registration file (password.epw) that you must
copy to the Elixir pc.

Copy the password.epw file to \Elixir and start the
installation.  
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Select [Prepare my initial product license registration.
This workstation is not connected to the Internet] from
the Registration Option menu, then click on [Next].

The application installation process will begin, see the
"Installation" section.

Soft key customers running Windows for Workgroups 3.1 or 3.11 

Since Windows 3.1/3.11 does not have internet capa-
bility, you must contact Elixir to obtain your password
file.   After installation of Elixir software, the installation
program verifies that the operating system is 3.1 or
3.11, runs passwd16.exe, and provides your machine
serial number. 

To complete registration: 

1. Enter your customer number, password and
PC number, then print out a copy of this
screen. 

2. Fax, email, or mail Elixir the display printout.
Elixir will generate a password.epw file and
send it to you on diskette. 

3. Load the password.epw file in the \ELIXIR
directory. 

The application installation process will begin, see the
"Installation" section.

Installation

This section describes how to install Elixir software
using the [Full] and [Custom] options. Installing addi-
tional Elixir applications to an existing version is also
explained.

Note: The software registration process must be com-
pleted (See the "Product Registration" section).
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For information about starting Elixir applications after
installation, refer to the "Introduction" chapter. 

During installation, the log file,  XWIN.log, is created in
the drive:\Elixir directory.  XWIN.log contains a list of
all directories and files copied or created, including in-
formation pertinent to the installation.  It can be ac-
cessed, using Notepad or Wordpad. 

If you have any problems running Elixir software after
installation, refer to the "Troubleshooting" section of
the Elixir Getting Started Guide for more information.

Installing Elixir applications

Elixir provides a simple, interactive procedure for in-
stalling Elixir applications.  

During installation you can select [Full] or [Custom]
installation.

Selecting a [Full] installs all Elixir applications and
demonstration files on the same drive.  If you
have a previous version of Elixir software, this op-
tion overwrites the existing version.

Selecting a [Custom] installation allows you to
choose the Elixir applications and options (such
as Elixir demonstration files) you want installed,
as well as where you want certain options in-
stalled.  For example, You may want the PDF
documentation in a different directory than the ap-
plication.

You can also install Elixir program files (required
to run Elixir), and data files (files that you create
or files such as the Elixir demonstration files), in
separate drives and directories.
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Full installation

To begin installation:

You can quit installation at any time, by pressing the
<Esc> key. 

1. Close all active applications.

2. Insert the CD in your CD-ROM drive.

3. In the "Welcome" screen, click on [Next].

The Release Notes? screen displays.

4. Select [Read Release Notes Now] to display
them in Wordpad (or Notepad), or click on
[Next] to proceed with the installation.

The Product Selection screen displays.

5. Select the applications you want to install and
click on [Next].

The Selected Products screen displays.

6. Verify the listed applications and click on
[Next].  If you need to delete or add to the list,
click on [Back] and reselect.

7. Verify your user information and click on
[Next].

8. In the Select Install Type screen, select [Full]
and click on [Next].

9. Select the drive on which you want Elixir
software installed, then click on [Next]. 

10. Select the Programs Folder in which you want
Elixir software installed (Elixir Applications is
the default), then click on [Next]. 
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11. In the Backup Replaced Files screen,  click on
[Yes], if you want to make back-up copies of
all files replaced during installation and select
the directory where the back-up files will be
placed. Then click on [Next].

12. In the Start Copying Files screen, click on
[Install].

Installation begins.

13. Once installation is complete, click on [Exit
Installer].

Custom installation

To begin installation:

You can quit installation at any time, by pressing the
<Esc> key. 

1. Close all active applications.

2. Insert the CD in your CD-ROM drive.

3. In the "Welcome" screen, click on [Next].

The Release Notes? screen displays.

4. Select [Read Release Notes Now] to display
them in Wordpad (or Notepad), or click on
[Next] to proceed with the installation.

The Product Selection screen displays.

5. Select the applications you want to install and
click on [Next].

The Selected Products screen displays.

6. Verify the listed applications and click on
[Next].  If you need to delete or add to the list,
click on [Back] and reselect.

7. Verify your user information and click on
[Next].
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8. In the Select Install Type screen, select
[Custom] and click on [Next].

9. In the Configuration Only? screen:

Selecting [Yes] allows you to load Configura-
tion, Program, and Data files into  any resi-
dent directory.

Selecting [No] allows you to deselect options
you do not wish installed.

10. Select the Programs Folder in which you want
Elixir software installed (Elixir Applications is
the default), then click on [Next]. 

11. In the Backup Replaced Files screen,  click on
[Yes], if you want to make back-up copies of
all files replaced during installation and select
the directory where the back-up files will be
placed. Then click on [Next].

12. In the Start Copying Files screen, click on
[Install].

Installation begins.

13. Once installation is complete, click on [Exit
Installer].

Adding applications

If you did not install all of the Elixir options while per-
forming the Custom installation procedure, you can do
so at any time by following the steps described in the
"Custom installation" section of this chapter.

Adding newly licensed applications

If you purchase additional Elixir products,  Elixir will
update your password file.  You can access the Prod-
uct Registration program from your program group
and re-download your initial product registration pass-
word file to activate your new products.
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3.   The Elixir PrintDriver 
and DocuTag

The easiest way to create normalized metacode EDL
files for DocuMerge is to use the Elixir PrintDriver in
conjunction with your Windows application.

        Figure 3-1.  Work flow using the Elixir PrintDriver

PC ENVIRONMENT WITH DOCUTAG
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Application
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Elixir
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Note:  The 9700 family of Xerox printers supported by
DocuTag includes: 97XX, 87XX, 4050, 4090, 4135,
4850, and 4890 printers.

With the Elixir Print Driver, ElixiTag, and DocuTag,
you can convert a Windows-based document with fully
defined DocuMerge BPSD tags into a normalized
metacode EDL file, ready for uploading to DocuMerge
on the host.

You install DocuTag and the PrintDriver (as one of the
standard Print Drivers in Windows), compose a
Windows-based document with data tags defined us-
ing ElixiTag, and select the printer option.  See the
Elixir PrintDriver User Guide for more detailed infor-
mation on the PrintDriver.

The Elixir PrintDriver, along with DocuTag, generates
normalized metacode and saves the resource in an
Elixir directory.

Using ElixiTag to add data tags

When creating new documents, you can add and/or
modify data tags within your Windows-based applica-
tion using ElixiTag.

Note:  In all Windows applications, data tags must be
inserted on a separate line, not as part of a
paragraph.

Also note that you can only specify left-justified text for
data tags.  You cannot use center, right, and full col-
umn justification, as the width of variable data charac-
ters may not correspond to the width of control
characters.

To use ElixiTag to create data tags:

1. Activate ElixiTag by  double-clicking on the
ElixiTag icon.

The ElixiTag dialog box displays.
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Figure 3-2.  ElixiTag dialog box

ElixiTag data tag options

You can create, add, or change Individual data tag at-
tributes within the ElixiTag dialog box.  Select the de-
sired field using the mouse or the arrow keys.  Details
on each of the options follow.

File
The File menu options include:

[Open] - open a tag list file

[Save] and [Save As] - save the file

[Exit] - exit ElixiTag

Help
The Help menu options include:

[Help on Current Field] - field where the cursor
displays

[Help on ElixiTag] - within the displayed dialog
box, click on any option that changes the cursor
to a hand for a description of that option
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[Customer Support] - provides phone numbers for
problem resolution and training information

[About] - how ElixiTag works with DocuTag

Search by Name
This field allows you to search by fieid name in your
tag list file to display the associated tag attributes.

Number
Select or enter the number of the field.  As you add
tags, ElixiTag automatically increments default field
numbers unless you enter a field number.  The default
numbers are sequential and start at 01.  The largest
field number permitted is 99.

Name
Enter the name of the variable data field.  You cannot
use spaces in this field.  ElixiTag automatically inserts
"_" when you press ths spacebar while in this field.  If
you want to separate words, use "." or "_" instead of
spaces.  The maximum allowable field name length is
30 characters.

Length
Enter the maximum number of characters allowable in
the specified field.

Replacement Char(acter)
DocuMerge variable data fields display in the docu-
ment as a string of replacement characters.  The re-
placement character is usually a @, !, #, or "
character.  It is a good idea to rotate the replacement
characters.  When you click on [Add New Tag], Elixi-
Tag automatically rotates the replacement character.
Enter the characters you choose.

Note:  You must enter replacement characters or
DocuTag will flag the document with an error flag.
Replacement characters should not be characters
used in the text data.

THE ELIXIR PRINTDRIVER AND DOCUTAG

3-4 ELIXIR TECHNOLOGIES CORPORATION



Mandatory
This option allows you to tell DocuMerge if the speci-
fied variable data field is mandatory or optional when
printing the document.

If you select Mandatory by entering an M in this
field, DocuMerge flags the document with an error
flag if the variable data is missing.

If you select Optional by entering an O in this
field, the document prints with blank spaces in
place of the replacement characters if the data is
missing.

Delete After Use
In some cases, documents use the same field name
more than once, but require different data values for
each use.  In these rare cases, delete the data tag af-
ter use.

If you want to delete after use, enter a Y for this
option.

If you require the same replacement data in each
field name reference, enter an N for this option
(the default).

Field End
Enter the character that matches the field end charac-
ter found in the DocuMerge variable data.  The default
is $.  You should specify a Field End character not
passed as variable data by DocuMerge.

Multi-Data
This option merges two different data fields when
printing.

N specifies there is only one variable data item
associated with the tag name (the default).

0 through 9 indicates the number of line feeds
you want generated between line breaks.

Note that the user should set [Delete After Use] to
YES when specifying a value for this field and the
[Length] should allow for the number of  line feeds you
generate.
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Align
When you select Multi-Data, enter a digit code to link
this Field Name with another for printing purposes.

Depth
Enter the number of lines in the specified variable
data field.  The default is 01.

Field Gen
This option allows you to include non-replacement
characters in the middle of a string of replacement
characters.  This is useful when formatting date fields
or telephone numbers.  For example, to separate the
month, day, and year in the date field with slashes,
type **/**/** (where * is the replacement character you
specified).

To print the telephone number, you can type (***)***-
**** (where * is the replacement character you
specified).

Enter the non-replacement characters as you want
them to display in relation to the replacement charac-
ters.  Maximum field length is 30 characters.

Comment
This option allows you to include a comment  relating
to the field (up to 31 characters).  For example, you
may want to enter a comment to distinguish the field
from another field that is similar.  (The comment does
not pass through the conversion process.)

Scroll by Number
You can scroll through the pre-defined tag list one tag
at a time or press and drag the scroll box to move for-
ward or backward in the tag list.

Add New Tag
Once you define a tag other than one that is in the list,
use this option to add it to the list for re-use.  This
saves the tag to your drive:\ELIXIR\DTTAGS.TAG file.

Delete Tag
This option deletes the selected tag from your
drive:\ELIXIR\DTTAGS.TAG file.
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Copy
This option copies the tag information to your Clip-
board.  Once you return to your Windows application,
you can paste the tag from the Clipboard into your
document.

2. Click on [Copy] to copy the data tag
information to the Clipboard.

3. Open your  Windows application and place
the cursor on the form where you want the
data tag to print.

4. From the Edit menu, select [Paste].  The tag
with replacement characters displays in the
document.

Note:  Once you have pasted a data tag into your
document, you cannot edit it.  You must delete the tag
and  create a new tag.

Graphics and fonts in Windows-based
documents 

If your document contains graphics, convert and out-
put them as fonts or in .IMG format.

Note:   Metacode will not accept .LGO formats.

The Elixir PrintDriver allows you to create text in your
Windows document using your choice of Xerox fonts,
Elixir format fonts, TrueType fonts, and Adobe Type
Manager (ATM) fonts.

If you want to use Xerox or Elixir format fonts, you
must import the fonts into the PrintDriver, generate
Windows and Elixir screen versions, and install the
fonts into Windows.

For a full description of how to generate fonts for the
PrintDriver and install them into Windows, see the
Elixir PrintDriver User Guide.
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Creating normalized metacode using the Elixir
PrintDriver

The Elixir PrintDriver provides you with a series of
easy-to-use dialog boxes to set up your print job op-
tions, select your output format, and specify the direc-
tories for your resources.

Note:  You must have the DT.EXE file present in your
drive:\ELIXIR directory to create a complete normal-
ized metacode (.NOR) file using the Elixir PrintDriver.
If the DT .EXE file is not present, an error message
displays when the program attempts to create the
.NOR file.

Setting up the PrintDriver

To set up the PrintDriver:

1. Select [Printer Setup] from the File menu of
your application.

2. Select the Elixir PrintDriver and the [Setup]
option.

The Main Setup dialog box displays.

  Figure 3-3.  Main Setup dialog box

From the Main Setup dialog box, you can control the
Print Job Options, PrintDriver Configuration, and Out-
put File Formats.

3. Select [Job Print Ticket].
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The Job Print Ticket dialog box displays.

Figure 3-4.  Job Print Ticket dialog box

4. Set the Job Print Ticket options and click on
[OK].

You return to the Main Setup dialog box.

Job Print Ticket options

The options in the Job Print Ticket control the overall
printing parameters for the print job.

Job ID
Specify a name for each file produced by the
PrintDriver.

In single page documents, you can enter up to six
characters in the job ID field.

In multiple page documents up to 9 pages, you
can enter up to five characters.  The PrintDriver
adds a one digit number to the end of the Job ID
name.

In multiple page documents with 10-99 pages,
you can enter up to four characters.  The Print-
Driver adds a two-digit number to the end of the
Job ID name.

THE ELIXIR PRINTDRIVER AND DOCUTAG

ELIXIR DOCUTAG USER GUIDE 3-9



In multiple page documents with 100-999 pages,
you can enter up to three characters.  The Print-
Driver adds a three-digit number to the end of the
Job ID name.

Drive
Specify the drive for all output files.

Paper size
Select the paper size and the orientation, [Portrait] or
[Landscape].  Click on the scroll arrow to display the
selections.

Description
Enter a short description of the print job to include with
the form.

Version/Revision
This option allows you to keep track of revisions made
to a document. 

Specify the primary version of the document in
the version window  (maximum two characters).

Specify the revision or modification identifier in
the revision window (maximum one character).

5. Select [Pre-Print Options].

The PrePrint dialog box displays.
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       Figure 3-5.  PrePrint dialog box

6. Set the options, select [NOR Meta] as the
output format, and click on [OK].

You return to the Main Setup dialog box.

Pre-Print Options

The Pre-Print dialog box displays the selected name
and output formats.  You can select the options now
or when you send your file to print.  See the "Creating
a print file" section for more information.

Job ID
Displays the Job ID name specified in the Job Print
Ticket dialog box.

Output Format
Displays the output options and directories the files
write to.  Note that the NOR Meta option output format
file directory is drive:\ELIXIR\DOCS\NRMETAOUT

Regenerate fonts
When you select the [Regenerate fonts] option, the
Font Generation Prompt dialog box displays the set-
tings for fonts already generated in your document.
This allows you to change previously selected set-
tings, for example, you may already have 9700 fonts
and now want to make 2700 fonts also.

7. Select [DocuTag Options].

The DocuTag Converter Options dialog box
displays.
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Figure 3-6.  DocuTag Converter Options dialog box

8. Set the options and click on [OK].

You return to the Main Setup dialog box.

DocuTag Converter Options

These options control the overall data tag parameters.

Tag attribute file
This is the name of the external tag attribute file.  The
file (drive:\ELIXIR\DTTAGS.TAG) contains definitions
of the data tags.  Note that the maximum number of
tags allowed in an external tag attribute file is 748.

          Figure 3-7.  Example external tag attribute file

The example file above shows data tag field numbers
and the attributes of each field number.  You can cre-
ate a new file or edit this file in any text editor.

In your Windows application, you may have marked
the location of data tags by adding tag position marker
(%%n).  The external tag attribute file automatically
specifies the attributes associated with each tag posi-
tion marker.

%%1 ADDRESS    20 $ O N % 0 4 1

%%2 CITY    25%# M Y $ 1 2 3

%%3 NAME    30 @ M N $ N 0 1

%%4 STATE     2 # M Y & N 1 1

%%5 ZIP   5 # O N # 4 0 5
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If you do not save the field number and attributes of
each data tag you defined while using ElixiTag ([Add
New Tag]), tag attributes assigned to the field number
overwrite using those found in the external tag attrib-
ute file.

When you convert your document to normalized meta-
code, the data tags you defined merge into your
document.

External Font File
When separate EDL members link together within
DocuMerge, the font list found in the first EDL mem-
ber in the linked series overrides all subsequent EDL
members in the series.  For this reason, it is usually
appropriate to include the same font list in all EDL
members used in a particular DocuMerge application. 

You may want to build your own external font list that
references all fonts used in your DocuMerge docu-
ments.  DocuTag adds those fonts to the common
font list it creates during conversion.  See the "Trans-
ferring font files between the host and PC" appendix
for more details.

Note:  Although DocuTag is capable of accepting up
to 127 fonts in an external font file, we recommend
that you not exceed 85 fonts in order to maximize
printer throughput.

JDL String
This option displays the current JDL entry and allows
you to enter a new JDL entry.

JDE String
This option displays the current JDE entry and allows
you to enter a new JDE entry.
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Page Bottom Marker
DocuMerge automatically assigns a page bottom
marker value to every normalized metacode file that
makes up a printed DocuMerge document.  This nu-
merical value indicates whether two normalized meta-
code EDL members can print on the same physical
page, and tells DocuMerge where to begin merging
the next normalized metacode EDL member in a
document.

In some cases, you may want to assign a different last
page bottom value to a particular file.  This is useful
when you wish to overlay consecutive pages in a
DocuMerge run.

The default is [Auto].  If you wish to assign a different
value, enter a number between 0 and 4200 in [Set to].
(This value represents the location of a dot on a page
with 4200 dots.) 

Text Justification
You can toggle between [Inter - Word] and [Inter -
Char].  If you select [Inter - Word], spaces add be-
tween words on a line when you justify the text.  If you
select [Inter - Char], spaces add between individual
characters.

Note: Although justification between characters may
sometimes look more easily readable, it can create a
very large file and add considerably to printing time.

X - Shift (horizontal shift)
Displays the current horizontal shift value and allows
you to enter a new value.  A positive value shifts print
output to the right, and a negative value shifts print
output to the left by the number of dots specified.

Y - Shift (vertical shift)
Displays the current Vertical Shift value and allows
you to enter a new value.  A positive shift value shifts
print output downward, and a negative shift value
shifts print output upward  by the number of dots
specified.
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Optimize
Select to decrease the number of bytes per record in
the .NOR file and increase the throughput from host to
printer.  Once the Elixir format file converts to a .NOR
file, you cannot convert it back to Elixir format for
editing.

Not selecting allows you to convert the .NOR file back
to an editable Elixir format file (such as using the
MET2ELX utility).

Report End String
Displays the current report end statement and allows
you to enter a new report end statement.  It specifies
the statement that signals the end of a report.  "RE-
PORT END" is the default.

Once you complete the DocuTag Converter Options,
click on [OK] or press <Enter>.

If any of the attribute options entered are incorrect or
left blank, a "Bad field entry!" error message displays
in the bottom left corner of your screen.  Press <En-
ter> to return to the incorrect or missing entry.

Based on the type of file (determined by the location
of the file and its file extension), one or more output
files with the correct file extensions generate and write
to the NorMeta Docs folder in the Documents Output
folder.

You can now upload the .NOR file(s) to the host.  See
the "Transferring files to the host" chapter.

Other options

Check the following options to ensure they are correct
for your print job:

Color services
Font mapping
Image services
Text services
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Creating a print file

The Elixir PrintDriver, using DocuTag, converts your
Windows-based document containing the fully defined
data tags into a normalized metacode EDL file.  The
file prints to your  \ELIXIR\DOCS\NRMETOUT
directory.

With your file open, perform the following steps to cre-
ate a .NOR file.

1. Select [Print] from the File menu of your
application, then [OK] in the Print dialog box.

The PrePrint dialog box displays.

          Figure 3-8.  PrePrint  dialog box

The Pre-Print dialog box displays the selected
name and output formats.  See the "Setting up
the PrintDriver" section for decriptions of the pre-
print options.

2. Set the options, select [NOR Meta] as the
output format, and click on [OK].

If you selected [Regenerate fonts] in the PrePrint
dialog box, the Font Generation Prompt dialog
box displays.
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     Figure 3-9.  Font Generation Prompt dialog box

3. Click on [OK] to accept the configuration.

The Elixir PrintDriver generates the print files in the
\ELIXIR\DOCS\DOCLIST (.DAT files in the Elixir
Documents folder) and \ELIXIR\DOCS\NRMETOUT
(.NOR files in the Output Documents folder) directo-
ries.  See the Elixir PrintDriver User Guide for more
detailed information.

You can now upload the .NOR files to the host as an
DocuMerge EDL member.  See the "Transferring files
to the host" chapter for detailed information.
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Limitations and considerations

This section describes considerations and limitations
when using DocuTag with the Elixir PrintDriver.

Editing tags created with ElixiTag

You cannot edit data tags created with ElixiTag in a
Windows application.  You must delete and re-enter
the tag information in the original Windows application
file, then convert and overwrite the .NOR file.

Number of data tags listed with ElixiTag

The name of the external tag attribute file in which the
attributes for the data tags in ElixiTag reside is
drive:\ELIXIR\DTTAGS.TAG.  Note that the maximum
number of tags allowed in a Tag attribute file is 748.
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4.  ElixiForm and DocuTag

ElixiForm and the Desktop allow you to work with
DocuMerge documents in a WYSIWYG environment
and to fully define or alter data tags.  You can also de-
fine the data tags while you create forms using Elixi-
Form.  For procedures on how to create a form, see
the ElixiForm User Guide.

      Figure 4-1.  Work flow using ElixiForm

Note:  The 9700 family of Xerox printers supported by
DocuTag includes: 97XX, 87XX, 4050, 4090, 4135,
4850, and 4890 printers.

EDL

DocuMerge

HOST ENVIRONMENT

PC ENVIRONMENT WITH DOCUTAG

ElixiForm

File transfer
package
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DocuTag also comes with a utility that converts exist-
ing normalized metacode files created by IBM's Docu-
ment Composition Facility/Plus (DCF+) to Elixir's
internal .ELX format and loads them into ElixiForm.  In
ElixiForm, single or multi-page documents (one page
at a time) can be easily modified.  Once a normalized
metacode EDL member imports into ElixiForm, the
member is editable, including the attributes assigned
to each data tag.  See the "Transferring files to the
host" chapter for detailed information.

Note:  The utility creates one Elixir form for each page
of a DocuMerge EDL member imported into Elixi-
Form.  If you modify a DocuMerge EDL member after
importing it into the Elixir system, you must modify
each of the individual forms that comprise the docu-
ment.  You can reassemble a series of forms into a
single normalized metacode file by using DocuTag.
See "Creating a .DAT file with .ELX forms" in this
chapter for detailed information.

ElixiForm does not create or modify multi-page docu-
ments.  If your document has multiple pages, you
should use one of the supported Windows applica-
tions to create the document.  If you add or delete
text, Ventura automatically re-paginates the document
for you.

Adding data tags in ElixiForm

Whether you're creating new forms or editing existing
forms, you can add and/or modify data tags within
ElixiForm.

Note:  In all Windows applications, data tags must be
inserted on a separate line, not as part of a
paragraph.

Also note that you can only specify left-justified text for
data tags.  Do not use center, right, and full column
justification, as the width of variable data characters
may not correspond to the width of control characters.
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Tag attributes and the external tag file

In your Windows application, you may have marked
the location of data tags by adding tag position marker
(%%n).  The external tag attribute file automatically
specifies the attributes associated with each tag posi-
tion marker.

The external tag attribute file
(drive:\ELIXIR\DTTAGS.TAG) contains definitions of
the data tags.

          Figure 4-2.  Example external tag attribute file

The example file above shows data tag field numbers
and the attributes of each field number.  You can cre-
ate a new file or edit this file in any text editor.

When you convert your document to a normalized
AFPDS file, the data tags you defined merge into your
document.

Starting ElixiForm

To start ElixiForm, open the Elixir Desktop and
double-click on the ElixiForm icon.  The ElixiForm win-
dow displays.

The Toolbox provides tools for creating and editing
the elements that make up a form.  The Toolbox dis-
plays on the left of the main work area.  If you cannot
see the Toolbox, you can display it any one of three
ways:

%%1 ADDRESS    20 $ O N % 0 4 1

%%2 CITY    25%# M Y $ 1 2 3

%%3 NAME    30 @ M N $ N 0 1

%%4 STATE     2 # M Y & N 1 1

%%5 ZIP   5 # O N # 4 0 5
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Pull down the Window menu and select
[Toolbox].

Press <F10>.

Select the [Toolbox Show/Hide] option in the
Toolbar.

To display the Text toolbox, select the Text tool or pull
down the Tools menu and select [Text].  The Text
toolbox displays.

Figure 4-3.  ElixiForm Text toolbox

To insert a tag:

1. Select the Text tool to display the Text
toolbox.

2. Select the Data Tags icon to activate data
tagging.

3. Select the font and text properties from the
Text toolbox.

4. Click in the form where you want to add a tag. 

The Data Tagging dialog box displays.
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      Figure 4-4.  Data Tagging dialog box

5. Enter the properties of the tag and click on
[OK] or press <Enter>.

The tag displays at the selected position.

6. After entering the tag attributes, deselect the
Data Tags icon and save the form to disk.

Data Tagging dialog box options

The following are data tag property options in the Data
Tagging dialog box.

Field Number
Enter the number of the field.  As you insert tags,
ElixiForm automatically increments default field num-
bers unless you enter a field number.  The default
numbers are sequential and start at 01.  The largest
field number permitted is 99.

Field Name
Enter the name of the variable data field.  You cannot
use spaces in this field.  DocuTag automatically in-
serts "_" when you press ths spacebar while in this
field.  If you want to separate words, use "." or "_" in-
stead of spaces.  The maximum allowable field name
length is 30 characters.
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Comment
When you select the [Comment] option, a window dis-
plays.  This allows you to enter a comment relating to
the field (up to 31 characters).  For example, you may
want to enter a comment to distinguish the field from
another field that is similar.  (The comment does not
pass on to the Converter.)

Field Length
Enter the maximum number of characters allowable in
the specified field.

Tag Field Depth
Enter the number of lines in the specified variable
data field.  The default is 01.

Replacement Character
DocuMerge variable data fields display in the docu-
ment as a string of replacement characters.  The re-
placement character is usually a @, !, #, or "
character.  It is a good idea to rotate the replacement
characters.  Enter the characters you choose.

Note:  You must enter replacement characters or
DocuTag will flag the document with an error flag.
Replacement characters should not be characters
used in the text data.

Field End Character
Enter the character that matches the field end charac-
ter found in the DocuMerge variable data.  The default
is $.  You should specify a field end character not
passed as variable data by DocuMerge.

Field Gen
This option allows you to include non-replacement
characters in the middle of a string of replacement
characters.  This is useful when formatting date fields
or telephone numbers.  For example, to separate the
month, day, and year in the date field with slashes,
type **/**/** (where * is the replacement character you
specified).
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To print the telephone number, you can type (***)***-
**** (where * is the replacement character you
specified).

Enter the non-replacement characters as you want
them to display in relation to the replacement charac-
ters.  Maximum field length is 30 characters.

Delete After Use
In some cases, documents use the same field name
more than once, but require different data values for
each use.  In these rare cases, delete the data tag af-
ter use.

If you want to delete after use, enter a Y for this
option.

If you require the same replacement data in each
field name reference, enter an N for this option
(the default). 

Mandatory/Optional
This option allows you to tell DocuMerge if the speci-
fied variable data field is mandatory or optional when
printing the document.

If you select [Mandatory], DocuMerge flags the
document with an error flag if the variable data is
missing.

If you select [Optional], the document prints with
blank spaces in place of the replacement charac-
ters, if the data is missing.

Multi-Data
This option links two different data fields when
printing.

N specifies there is only one variable data item
associated with the tag name (the default).

0 through 9 indicates the number of line feeds
you want generated between line breaks.
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Note that the user should set [Delete After Use] to
YES when specifying a value for this field and the
[Length] should allow for the number of  line feeds you
generate.

Tag Align
Enter a two-digit code to link this Field Name with an-
other for printing purposes.

Saving a form

You should periodically save your work as you design
a form, and again when you finish the form.

To save a form:

1. From the File menu, select [Save Form As] or
press <F7>.

The Save Form As dialog box displays.

      Figure 4-5.  Save Form As dialog box

2. Enter a name in the [File name] option.   You
do not need to type an extension. 

If you are saving an existing form under a new
name, enter the new name.   The original file still
exists with the original name.
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If you plan to convert your form to other formats,
save the form with a maximum six-letter file
name.  Longer file names truncate upon conver-
sion and result in overwriting existing files.

Note:  To display the version and revision characters
of the .ELX file in ElixiForm, pull down the Options
menu and select [Page Databasing].

3. Click on [OK] or press <Enter>.

Once you save a form, use <Ctrl> + <S> to quick-save
your work.

When you return to the form, you will see a replace-
ment character string that denotes the variable data
field.

If you do not see the replacement character string, the
font you are using may not contain the specified re-
placement character.  You will need to specify another
font.

When adding text, you can check the soft keyboard to
see whether or not a particular font contains the re-
placement character you've specified.

Soft keyboard 

The soft keyboard allows you to enter characters that
are not available on a standard keyboard.

To type an extended character:

1. Place the cursor in the work area where you
want the character to display.

2. Select the [Soft Keyboard] option.

 The soft keyboard displays.

               Figure 4-6.  Soft Keyboard
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3. Select a character in the soft keyboard.

The character displays in the selected position.

4. Deselect the [Soft Keyboard] option.

You can also access the non-standard keyboard char-
acters by typing the decimal value of the non-standard
keyboard character.

The soft keyboard displays characters in the current
font size and smaller fonts may be difficult to read.
You can change the current font to a larger point size,
edit using the soft keyboard, then change the text
block back to the smaller font after completing the
edit.

Note:  The maximum size of a tag that displays on the
screen is 2000 bytes.  You can calculate by multiply-
ing the tag length by the tag depth.  A tag greater than
2000 bytes in size displays in ElixiForm as a line of
text with the tag name and all of its attributes, not as a
series of replacement characters.  A tag displaying as
a tag name still prints the all variable data.

Editing data tags

Once you have set the attributes for data tags in your
form, it is simple to delete, change, move, or copy
them.

Deleting data tags

To delete a tag within a text block:

1. Select the Select/Edit tool.

2. Select the tag.

3. Select the [Delete] option or press <Del>.

You delete the tag and all of its attributes from the
form.

To delete a text block:
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1. Select the text block.

2. Select the [Delete] option or press <Del>.

You delete the selected text block from the form.

3. To undelete the tag or text block, pull down
the Edit menu and select [Undo] or click on
the [Undo] option in the Toolbar.

Changing data tag attributes

You must select a tag before you can edit it.  To select
a tag :   

1. Select  the Select/Edit tool in the Toolbox.

2. Place the cursor on the tag you want to edit.

3. Click the right mouse button.

The Data Tagging dialog box displays.

4. Move the cursor to the appropriate field and
make the changes.  Click on [OK] or press
<Enter> to save the changes to disk and
return to your form.

5. Right-click the mouse to end the edit mode.

Moving data tags

To move a tag :

1. Select the Select/Edit tool in the Toolbox.

2. Choose the direction for moving the tag:
[Horizontal], [Vertical], or [Free].

[Horizontal] allows you to move the tag only in a
left-and-right direction.

[Vertical] allows you to move the tag only in an
up-and-down direction.

[Free] allows you to move the selected tag to any
location on the form.
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3. Select the tag you want to move.

The cursor changes to a hand.

4. Place the cursor over the tag and click and
hold the left mouse button.

5. Drag the tag to where you want it on the form.

6. Release the mouse button to accept the tag
position.

You can also move the tag by entering new coordi-
nates:

1. Select the [Screen Pointer Coordinates]
option displayed in the Toolbar.

2. Overwrite the old values with the new
coordinate values.

The tag adjusts to the new coordinates when you click
the left mouse button or press <Enter>.

Copying data tags

To make multiple copies of a text block:

1. Select the Select/Edit tool in the Toolbox.

2. Select the [Copy] option.

3. Choose the direction for copying:
[Horizontal], [Vertical], or [Free].

[Horizontal] allows you to copy the tag only in a
left-and-right direction.

[Vertical] allows you to copy the tag only in an up-
and-down direction.

[Free] allows you to move the selected tag to any
location on the form.

4. Select the text block you want to copy.  
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Brackets display around the selected text.

5. Click on the up or down arrows to select the
number of copies between 1 and 99.

Hold down the <Ctrl> key while clicking on the ar-
rows to increase or decrease the value by 10.
You can also backspace over the value and enter
a new value from the keyboard.

6. Drag the block of text in the direction in which
you want to make copies.

Creating a .DAT file from .ELX forms

Before you can create a normalized metacode EDL
file, you must add the .ELX form(s) into a .DAT file.

You can create a .DAT file in two ways:

create and name a new file with the Elixir Docu-
ments folder open

drag and drop the .ELX file(s) from the Elixir
Forms folder onto an empty space in the Elixir
Documents folder.

Creating a new .DAT file in the Elixir Documents folder

To create a .DAT file in the Elixir Documents folder:

1. Open the Documents folder, and the Elixir
Documents folder.

2. From the File menu, select [New].

The File Name Entry dialog box displays.
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Figure 4-7.  File Name Entry dialog box

3. Enter a file name with the .DAT extension in
the [Selecting File(s)] option and click on
[OK].

You can now copy the .ELX files into the .DAT file

Copying the .ELX files to the Elixr Documents folder

To create a .DAT file from the Elixir Forms folder:

1. Open the Forms folder, and the Elixir Forms
folder.

2. Select and drag the .ELX files to the
Documents folder.

Your cursor becomes a multi-page pointer.

3. Click on the Elixir Documents folder then click
on any empty space in the  file folder.

The File Name Entry dialog box displays.

          Figure D-1.  File Name Entry dialog box

4. Enter a file name in the [Selecting File(s)]
option and click on [OK].

Although the screen returns to the Elixir Forms folder,
the new .DAT file now resides in the Elixir Documents
folder.
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Viewing and editing a .DAT file

You may want to view and edit a .DAT file to ensure
all the .ELX files are present and sequenced accord-
ing to the order you want them to print.

To view the .DAT file, double-click on the file or drag
and drop it on the Viewer icon..

The ASCII-based Windows Notepad dialog box opens
displaying the contents of the .DAT file.  You can now
edit the file.

If you want to add .ELX files, repeat the steps
provided in "Copying the .ELX files to the Elixr
Documents folder", but instead of dropping the
files onto an empty space, drop them onto the
.DAT file.

If you want to edit or sequence the .ELX files, use
the editing (cut, copy, paste, etc.) options in the
Notepad Edit menu.

Your .DAT file is now ready for conversion to a nor-
malized metacode file.

Proof-printing a .DAT file

To proof-print a .DAT file, copy it to the Printers icon
on the Desktop (or select [Print] from the File menu,
or press <Ctrl> + <P>).  

ELIXIFORM AND DOCUTAG

ELIXIR DOCUTAG USER GUIDE 4-15



Generating normalized metacode

The simplest way to convert a file is to use the Desk-
top Converter.  To convert a file or files, follow these
steps:

1. Select the file(s) you want to convert from the
Elixir or Input folder of the Documents folder.

2. Copy (drag and drop) the file(s) to the
Converter icon.

The Document Converter Option dialog box displays.

     Figure 4-8.  Document Converter Options
  dialog box

3. Select the [NorMeta] output format and click
on [OK] or press <Enter>.

The DocuTag Converter Options dialog box
displays.

         Figure 4-9.  DocuTag Converter Options dialog box
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DocuTag Converter Options

The following are data tag property options in the
DocuTag Converter and Extended Converter Options
dialog boxes.

Tag attribute file
This is the name of the external tag attribute file.  The
file (drive:\ELIXIR\DTTAGS.TAG) contains definitions
of the data tags.  Note that the maximum number of
tags allowed in an External Tag Attribute File is 748.

            Figure 4-10.  Example external tag attribute file

The example file above shows the %%n tag markers
where n is the field number followed by a list of the at-
tributes for each field number.  You can create or edit
this file in any text editor.

In your Windows application, you may have marked
the location of data tags by adding tag position marker
(%%n).  The external tag attribute file automatically
specifies the attributes associated with each tag posi-
tion marker.

When you convert the .ELX document to normalized
metacode, the tag position marker merges into your
document and matches the attributes assigned to the
field number listed in the external tag attribute file.  If
any of the data tags in the Elixir form files have un-
specified attributes, tag attributes assigned to the field
number overwrite using those found in the external
tag attribute file.

External Font File
When separate EDL members link together within
DocuMerge, the font list found in the first EDL mem-
ber in the linked series applies to all subsequent EDL
members in the series.  For this reason, it is usually
appropriate to include the same font list in all EDL
members used in a particular DocuMerge application.

%%1 ADDRESS    20 $ O N % 0 4 1

%%2 CITY    25%# M Y $ 1 2 3

%%3 NAME    30 @ M N $ N 0 1

%%4 STATE     2 # M Y & N 1 1

%%5 ZIP   5 # O N # 4 0 5
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You may want to build your own external font list that
references all fonts used in your DocuMerge docu-
ments.  DocuTag adds those fonts to the common
font list it creates during conversion.  You create this
file using any ASCII text editor to build a list of the
names of each font with no filename extensions.  Fol-
low each name with <Enter>.  (This inserts a carriage
return/line feed after each font name.)

Note:  Although DocuTag is capable of accepting up
to 127 fonts in an external font file, we recommend
that you not exceed 85 fonts in order to maximize
printer throughput.

JDL String
This field shows the current JDL entry and allows you
to enter a new JDL entry.

JDE String
This field shows the current JDE entry and allows you
to enter a new JDE entry.

Page Bottom Marker
DocuMerge automatically assigns a page bottom
marker value to every normalized metacode file that
makes up a printed DocuMerge document.  This nu-
merical value indicates whether two normalized meta-
code EDL members can print on the same physical
page, and tells DocuMerge where to begin merging
the next normalized metacode EDL member in a
document.

In some cases, you may want to assign a different last
page bottom value to a particular file.  This is useful
when you wish to overlay consecutive pages in a
DocuMerge run.

The default is [Auto].  If you wish to assign a different
value, enter a number between 0 and 4200 in [Set to].
(This value represents the location of a dot on a page
with 4200 dots.) 

Text Justification
You can toggle between [Inter - Word] and [Inter -
Char].  If you select [Inter - Word], spaces add be-
tween words on a line when you justify the text.  If you
select [Inter - Char], spaces add between individual
characters.
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Note:  Although justification between characters may
sometimes look more easily readable, it can make for
a very large file and add considerably to printing time.

Output to
You can toggle between [Tape] and [Disk].  If [Tape] is
selected and there is a tape unit connected, the nor-
malized metacode file writes to tape.

If you select [Tape] and have no tape on the system,
DocuTag automatically writes the normalized meta-
code file to disk.

Image Compression
You can toggle between [NONE], [PARTIAL], and
[FULL].

[NONE] causes DocuTag not to compress .IMG files.

[PARTIAL] partially optimizes the .IMG files by com-
pressing both duplicate lines and blank (null) lines
within the .IMG file.

[FULL] also optimizes white space within lines in the
.IMG file.  [FULL] takes the longest time and produces
the smallest .IMG files.  If you are dealing with docu-
ments that have graphics of more than a half page
and you are printing on a Xerox 8700 or 9700 series
printer, you should select [FULL].

Optimize
Select to decrease the number of bytes per record in
the .NOR file and increase the throughput from host to
printer.  Once the Elixir format file converts to a .NOR
file, you cannot convert it back to Elixir format for
editing.

Not selecting allows you to convert the .NOR file back
to an editable Elixir format file (such as using the
MET2ELX utility).

Elixir Document in
Displays the default Documents folder directory.  You
can type in a new directory name and, once you click
on [OK] or press <Enter>, it saves as the current
directory.
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Screen Fonts in
Displays the default Fonts folder directory.  You can
type in a new directory name and, once you click on
[OK] or press <Enter>, it saves as the current
directory.

4. Once you have set these converter options,
click on [OK] or press <Enter>.

The DocuTag Extended Converter Options dialog
box displays.

             Figure 4-11.  DocuTag Extended Converter Options
      dialog box

DJDE Prefix
This option displays the current $DJDE$ entry and al-
lows you to enter a new $DJDE$ entry.  It also allows
you to specify the Dynamic Job Descriptor Entry string
coded in the PREFIX statement of your printer's JSL.
The PREFIX statement specifies the string that delim-
its the start of a DJDE record within the normalized
metacode datastream.

The string can be up to 20 characters long.  It is ex-
tremely important that the PREFIX statement delimiter
specified in DocuTag is identical to the delimiter speci-
fied in the PREFIX parameter of the JSL used in your
environment.

Offset
The number of characters or spaces present before
the first string character of the $DJDE$ string.  You
can change this option by entering a new value.
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Skip
The total number of characters or spaces to skip be-
fore reading a command.  You can change this option
by entering a new value.  

Replacement Char(acter)s
DocuMerge variable data fields display in the docu-
ment with a string of replacement characters.  The re-
placement character is usually a @, !, #, or "
character.  It is a good idea to rotate the replacement
characters.  Enter the characters you choose.

Note:  You must enter replacement characters or
DocuTag will flag the document with an error flag.
Replacement characters should not be characters
used in the text data.

Field End Char
Enter the character that matches the field end charac-
ter found in the DocuMerge variable data.  The default
is $.  You should specify a Field End character not
passed as variable data by DocuMerge.

X - Shift (horizontal shift)
Displays the current horizontal shift value and allows
you to enter a new value.  A positive value shifts print
output to the right, and a negative value shifts print
output to the left by the number of dots specified.

Y - Shift (vertical shift)
Displays the current vertical shift value and allows you
to enter a new value.  A positive shift value shifts print
output downward, and a negative shift value shifts
print output upward  by the number of dots specified.

File Generation
This option allows you to tell DocuMerge if the speci-
fied variable data field is [Mandatory] or [Optional]
when printing the document.  With [Mandatory] se-
lected, DocuMerge will flag the document with an er-
ror flag if the variable data is missing.  If  you select
[Optional], the document  prints with blank spaces in
place of the replacement characters, if the data is
missing.  The default is 0.

Multi-Data
This toggle option links two different data fields when
printing.
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N specifies there is only one variable data item
associated with the tag name (the default).

0 through 9 indicates the number of line feeds
you want generated between line breaks.

Note that the user should set [Delete After Use] to
YES when specifying a value for this field and the
[Length] should allow for the number of  line feeds you
generate.

Delete After Use
In some cases, documents use the same field name
more than once, but require different data values for
each use.  In these rare cases, delete the data tag de-
leted after use.

If you want to delete after use, enter a Y for this
option.

If you require the same replacement data in each
field name reference, enter an N for this option
(the default).

Field Gen
This option allows you to include non-replacement
characters in the middle of a string of replacement
characters.  This is useful when formatting date fields
or telephone numbers.  For example, to separate the
month, day, and year in the date field with slashes,
type **/**/** (where * is the replacement character you
specified).

To print the telephone number, you can type (***)***-
**** (where * is the replacement character you
specified).

Enter the non-replacement characters as you want
them to display in relation to the replacement charac-
ters.  Maximum field length is 30 characters.

Report End String
Displays the current report end statement and allows
you to enter a new report end statement.  It specifies
the statement that signals the end of a report.
"REPORT END" is the default.  

ELIXIFORM AND DOCUTAG

4-22 ELIXIR TECHNOLOGIES CORPORATION



5. Once you complete the DocuTag Converter
Options, click on [OK] or press <Enter>.

If you enter any of the attribute options incorrectly or
leave them blank, a "Bad field entry!" error message
displays in the bottom left corner of your screen.
Press <Enter> to return to the incorrect or missing
entry.

The Elixir Exec dialog box

Once conversion begins, the Elixir Exec dialog box
displays conversion progress and error or warning
information.

Conversion progress

Conversion progress displays in the middle of the dia-
log box.  When conversion is complete and free of er-
rors, the Elixir Exec dialog box prompts you to "Press
any key to continue...".  Press a key.

You can now upload the .NOR files to the host.  See
the "Transferring files to the host" chapter.

Error and Warning messages

Once conversion is complete, if there are any error or
warning messages, they display under the heading:

 Desktop Reports ERROR or WARNING in DocuTag Converter.

Example  message:

Could not open:
drive:\DIRECTORY\FILE
Press any key to continue...

Make corrections and re-convert until no errors or
warnings display.

Based on the type of file (determined by the location
of the file and its file extension), one or more output
files with the correct file extensions generate and write
to the NorMeta Docs folder in the Output folder.
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Frequently used data tags

One of the helpful features of ElixiForm is its ability to
store and reload frequently used data tags.  You can
store these tags with all of their DocuMerge data tag
attributes as ElixiForm form fragments.  When you
need them, you can simply merge them into your form
without having to re-specify all the tag attributes.

Creating frequently used data tags

To begin, load a new form, then perform the following
steps:

1. Select the Text tool in the Toolbox.

2. Select the Data Tags icon to activate data
tagging.

3. Select the font and text properties from the
Text toolbox.

4. Click on the form where you want to add a
tag.

The Data Tagging dialog box displays.

      Figure 4-12.  Data Tagging dialog box

5. Enter the properties of the tag (see the "Data
Tagging dialog box options section) and click
on [OK] or press <Enter>.

The tag displays at the selected position.
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Repeat these steps for each frequently used data tag
you wish to store.

Creating a Form Group of frequently used data tags 

After you've specified the data tag attributes for each
tag, you can save frequently used tags as a form
group with its own name by performing the following
steps:

1. Select the Select/Edit tool in the Toolbox.

2. Move the screen pointer near the elements
you want to group.

Grouped text displays in brackets.

3.  Drag the dotted line so it encloses all the
elements you want in the group.

Handles display around or inside each element in
the group.

4. Release the mouse button.

5. From the File menu, select [Save Form
Group].

6. Enter a file name.

Give the file a name that refers to the name or
number of the data tag. The directory used for
storing form groups is either
\ELIXIR\FORMS\ELIXIR\DEMO\*.ELX or your
previously established default directory.

7. Click on [OK] or press <Enter>.

The form group saves in the specified forms
directory.

8. Repeat these steps for each frequently used
data tag.
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These DocuMerge BPSD tags are now available for
reuse as needed.  When you are in a form file that re-
quires one of these frequently used data tags, you
may recall the appropriate form group by selecting
[Merge Form Group] in the File menu.

After you select the data tag form fragment file you
want and click on [OK] or press <Enter>, the replace-
ment character string displays in the work area of the
screen.  You may then edit, modify, or move the data
tag.
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5.  VP297 and DocuTag

If you do not have the Elixir PrintDriver, you may use
Ventura Publisher with VP297 to create Elixir form
files that DocuTag can process into normalized meta-
code EDL members.

     Figure 5-1.  Work flow using  VP297

Conversion of Ventura Publisher files is possible only
if Elixir VP297 resides on your PC.  For details on con-
version and printer setup, see the VP297 User Guide.

PC ENVIRONMENT WITH DOCUTAG

EDL

DocuMerge

HOST ENVIRONMENT

Ventura
Publisher

VP297

ElixiForm

File transfer

package
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You can convert Ventura Publisher files only if Elixir
VP297 resides on your PC.

When you install Ventura Publisher and specify the
Xerox 4045 as your printer, you can produce XES-
format .C00 print files by printing VP documents to
disk using the 4045 or 4850 print option.  You can
then convert the .C00 files to Elixir document, Xerox
online and offline metacode, .FSL, and .FRM formats.

This chapter describes how to convert Ventura Pub-
lisher format (.C00) files into Elixir format using
VP297.

Note:  The 9700 family of Xerox printers supported by
DocuTag includes: 97XX, 87XX, 4050, 4090, 4135,
4850, and 4890 printers.

How DocuTag works with Ventura Publisher

To convert a Ventura Publisher (.C00 file) document
to a normalized metacode EDL member, you must
first convert the document to Elixir form file format.
Convert each page of the original Ventura document
to an Elixir form file.  Each file name uses the first
three characters of the .C00 file name followed by a
three-digit sequence number.

The names of all the Elixir form files that collectively
comprise the original document reside in a form list
created automatically by VP297.  These files have an
extension of .DAT, as shown in the following figure.
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Figure 5-2.  Form list file example

.C00 Ventura print file naming conventions

If you are using VP297 to convert multiple .C00 Ven-
tura print files into Elixir form files, the Elixir form files
created may  overwrite older files during a subsequent
conversion.  You can avoid this by making certain that
the names of the .C00 files you convert differ by the
first three characters.

For example, if you convert two three-page .C00 files
and the names of the two files were ANNDOC.C00
and ANNDOC2.C00, the Elixir form files created by
VP297 become ANN001.ELX, and ANN002.ELX.  If
both .C00 files converted successively, the Elixir form
files generated by the conversion of ANNDOC.C00
are overwritten by the Elixir form files created when
ANNDOC2.C00 converted.

You can prevent overwriting files either by changing
the first three characters of the .C00 print file names
so that they are distinctive, or by renaming the Elixir
form files in DOS so that you do not overwrite them
during a later VP297 conversion.

VP297 AND DOCUTAG

ELIXIR DOCUTAG USER GUIDE 5-3



The external tag attribute file

The external tag attribute file contains definitions of
the BPSD tags (drive:\ELIXIR\DTTAGS.TAG).  Note
that the maximum number of tags allowed in an Exter-
nal Tag Attribute File is 748.

            Figure 5-3.  Example external tag attribute file

The example file above shows the %%n tag markers
where n is the field number followed by a list of the at-
tributes for each field number.  You can create or edit
this file in any text editor.

In Ventura Publisher, you may have marked the loca-
tion of BPSD tags by adding tag position markers
(%%n).  The external tag attribute file automatically
specifies the attributes associated with each tag posi-
tion marker.

When you convert the .ELX document to normalized
metacode, the tag position marker merges into your
document and matches the attributes assigned to the
field number listed in the external tag attribute file.  If
any of the BPSD tags in the Elixir form files have un-
specified attributes, tag attributes assigned to the field
number overwrite those found in the external tag at-
tribute file.

Graphics in Ventura documents 

If you must place graphics on your Ventura docu-
ments, convert them to fonts or .IMG format.

%%1 ADDRESS    20 $ O N % 0 4 1

%%2 CITY    25%# M Y $ 1 2 3

%%3 NAME    30 @ M N $ N 0 1

%%4 STATE     2 # M Y & N 1 1

%%5 ZIP   5 # O N # 4 0 5
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Using new Ventura fonts with DocuTag

If you plan to use fonts other than the Swiss, Dutch,
Courier, and Symbol fonts supplied with Ventura, you
must create both Elixir screen and Xerox centralized
printer versions of the fonts.  You must also create a
kerning table for the font that VP297 uses when your
Ventura document converts.

To create these font formats, generate either Xerox
4045 or HP LaserJet proof printer versions of the
fonts (usually by using Bitstream Fontware).  Then
use the converters in the Elixir Desktop to convert ei-
ther of these proof printer formats to Xerox centralized
printer font and Elixir screen font formats.

To create the kerning table VP297 needs, you must
use the MAKEKRN utility supplied with VP297.  For
details on how to use the MAKEKRN utility, see the
VP297 User Guide.

Adding BPSD tags to Ventura Documents

If you are using Ventura Publisher to create Elixir form
files and form file lists, there are two ways to add
BPSD tags to your document:

add BPSD tag position markers in Ventura, then
add the tags after conversion using ElixiForm

add BPSD tags after conversion in ElixiForm

Adding BPSD tag position markers in Ventura

To denote where a BPSD tag begins in a Ventura
source document, you must insert a tag position
marker (%%n).

The BPSD tag field number following the percent
signs, represented by n, may be any number from 1 to
748.  The field number must directly follow the two
percent signs.  
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BPSD tag position marker considerations

In order to detect BPSD tag position marker locations,
VP297 expects the %%n tag position markers to be
contiguous strings in the Ventura Publisher .C00 print
file.  To ensure VP297 identification of the tags,  a tag
position marker must be a left justified text item or a
justified text item in a paragraph that has the Letter
Spacing option set to [OFF].

Note: You may turn off [Letter Spacing] for a BPSD
tag position marker by changing the setting found in
the Paragraph Typography sub-menu of the Para-
graph menu in Ventura.

Make an appropriate amount of space available in the
source Ventura document to accommodate the vari-
able data associated with a BPSD tag position
marker.

You can ensure that the space is available by posi-
tioning tags on their own line, or by using spacing
characters, tabs, or frames to occupy the desired
amount of white space immediately following the tag.
BPSD tag replacement characters will not wrap from
one line to the next.  Variable data position starting at
the location of the first % sign of the %%n tag marker.

Adding BPSD tags in ElixiForm

You can post-process VP297-generated Elixir form
files using ElixiForm.  This method allows insertion of
BPSD tags in WYSIWYG mode.  You can also use
ElixiForm to assign tag attributes to each tag position
marker.  See the "ElixiForm and DocuTag" chapter.

Creating Elixir form files from VP documents

After you create your Ventura document, print the
document to disk with the printer output option set to
Xerox 4045 or 4850 driver, highlight color, and 300
dpi.  This produces a disk print file with a file exten-
sion of .C00.  
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You can then use VP297 and DocuTag in the
Elixir/ElixiSys Desktop to convert the document to nor-
malized metacode format.

To ensure that your tag position markers display as
contiguous text strings in the Ventura print file, make
sure that all the 4045 proof printer fonts used in your
document exist in the \VENTURA directory on the
drive on which Ventura installs.  If Ventura does not
find the fonts, the .C00 print files generated may not
be in a format that allows VP297 to recognize the tag
position markers.

To convert your Ventura document to an Elixir format
file:

1. Copy the .C00 file from the Ventura UDK
folder in the Input Documents folder to the
Converter icon.

The Document Converter Options dialog box
displays.

             Figure 5-4.  Document Converter Options
          dialog box

2. Select  [Elixir] as the output format and click
on [OK].

The VP297/HP2XRX Converter Options dialog box
displays.
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             Figure 5-5.  VP297/HP2XRX Converter Options 
        dialog box

This dialog box allows you to specify parameters for
running VP297 conversion program.  For more infor-
mation, see the VP297 User Guide.

Other options in this dialog box are grayed-out and/or
do not apply to this conversion.

DJDE Entry
The  Dynamic Job Descriptor Entry coded for the
PREFIX statement in your printer ELIXIR.JSL file, or
the default JSL if printing online files.  See the VP297
User Guide for more information.

X and Y shift
The number of dots you want the pages of the output
file shifted in the X and Y directions.

Copies
The number of copies to print.

Output to
Select [Disk] or [Tape] as your output medium.

Output Pages as
Applicable for Xerox production (9700) output only.
Select [Simplex] (one-sided) or [Duplex] (two-sided).
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Clean Up Files
Select this option to create a command file to delete
the files used for the job.

Format Graphics as
Converts graphics to images [IMGs] or fonts [Fonts]
format.  See the VP297 User Guide for more
information.

Compress IMG Graphics as
For .IMG image files, [Partial] compresses duplicate
lines and blank (null) lines, [Full] compresses dupli-
cate lines, blank lines, and optimizes for white space.
[None] does not compress files.
 
Use [None] if you want to use PageHandler after
conversion.

Elixir Documents
The default directory for Elixir Document Lists is
drive:\ELIXIR\DOCS\DOCLIST.

3. Click on [OK].

The Extra Converter Options dialog box displays.

       Figure 5-6.  Extra Converter Options dialog box

Color Output
[None] is the default.  Other options in this dialog box
are grayed-out and do not apply to this conversion.

4. Click on [OK].

 The Elixir Exec dialog box displays.
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The Elixir Exec dialog box

Once conversion begins, the Elixir Exec dialog box
displays conversion progress and error or warning
information.

Conversion progress

Conversion progress displays in the middle of the dia-
log box.  When conversion is complete and free of er-
rors, the Elixir Exec dialog box prompts you to "Press
any key to continue...".  Press a key.

Your file is now in Elixir format.  See the "ElixiForm
and DocuTag" chapter for details on adding or defin-
ing BPSD tags.

Error and Warning messages

Once conversion is complete, if there are any error or
warning messages, they display under the heading: 

Desktop Reports ERROR or WARNING in DocuTag Converter.

Make corrections and re-convert until no errors or
warnings display.

Proof-printing your document

Using ElixiForm, you can proof print the series of
forms created by VP297 on a PC-attached laser
printer, such as the Xerox 4045 or HP LaserJet IID.

Converting form lists in DocuTag

Before converting Elixir form files that only contain tag
position markers, you need to assign attributes to
each tag position marker.  For details on performing
this operation and converting your files to normalized
metacode format, see the "ElixiForm and DocuTag"
chapter.

VP297 AND DOCUTAG

5-10 ELIXIR TECHNOLOGIES CORPORATION



6.  HP2XRX and DocuTag

If you do not have the Elixir PrintDriver, you may use
HP2XRX with your supported document application to
create Elixir form files that DocuTag can process into
normalized metacode EDL members.

See the "Supported Windows applications" section for
a list of supported products.

    Figure 6-1.  Workflow using HP2XRX
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   HP2XRX converts Hewlett Packard Printer Control
Language (PCL level IV or below) format files.

Conversion of application files is possible only if Elixir
HP2XRX resides on your PC.  For details on conver-
sion and printer setup, see the HP2XRX User Guide.

Example:  When you install Ventura Publisher and
specify an HP printer, you can produce .HP-format
print files by printing VP documents to disk using the
HP LJ Series II driver.  You can then convert the .HP
files to Elixir document, Xerox online and offline meta-
code, .FSL, and .FRM formats using HP2XRX.

This chapter describes how to convert .HP files into
Elixir format using HP2XRX.

Note:  The 9700 family of Xerox printers supported by
DocuTag includes: 97XX, 87XX, 4050, 4090, 4135,
4850, and 4890 printers.

How DocuTag works with HP documents

To convert a (.HP file) document to a normalized
metacode EDL member, you must first convert the
document to Elixir form file format.  Convert each
page of the original document to an Elixir form file.
Each file name uses the first three characters of the
.HP file name followed by a three-digit sequence
number.

The names of all the Elixir form files that collectively
comprise the original document reside in a form list
created automatically by HP2XRX.  These files have
an extension of .DAT, as shown in the following figure.
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Figure 6-2.  Form list file example

.HP print file naming conventions

If you are using HP2XRX to convert multiple .HP print
files into Elixir form files, the Elixir form files created
may  overwrite older files during a subsequent conver-
sion.  You can avoid this by making certain that the
names of the .HP files you convert differ by the first
three characters.

For example, if you convert two three-page .HP files
and the names of the two files were ANNDOC.HP and
ANNDOC2.HP, the Elixir form files created by
HP2XRX become ANN001.ELX, and ANN002.ELX.  If
both .HP files converted successively, the Elixir form
files generated by the conversion of ANNDOC.HP are
overwritten by the Elixir form files created when
ANNDOC2.HP converted.

You can prevent overwriting files either by changing
the first three characters of the .HP print file names so
that they are distinctive, or by renaming the Elixir form
files in DOS so that you do not overwrite them during
a later HP2XRX conversion.
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The external tag attribute file

The external tag attribute file contains definitions of
the BPSD tags (drive:\ELIXIR\DTTAGS.TAG).  Note
that the maximum number of tags allowed in an Exter-
nal Tag Attribute File is 748.

          Figure 6-3.  Example external tag attribute file

The example file above shows the %%n tag markers
where n is the field number followed by a list of the at-
tributes for each field number.  You can create or edit
this file in any text editor.

In your Windows application, you may have marked
the location of BPSD tags by adding tag position
markers (%%n).  The external tag attribute file auto-
matically specifies the attributes associated with each
tag position marker.

When you convert the .ELX document to normalized
metacode, the tag position marker merges into your
document and matches the attributes assigned to the
field number listed in the external tag attribute file.  If
any of the BPSD tags in the Elixir form files have un-
specified attributes, tag attributes assigned to the field
number overwrite those found in the external tag at-
tribute file.

Graphics in .HP documents 

If you must place graphics on your documents, con-
vert them to fonts or .IMG format.

%%1 ADDRESS    20 $ O N % 0 4 1

%%2 CITY    25%# M Y $ 1 2 3

%%3 NAME    30 @ M N $ N 0 1

%%4 STATE     2 # M Y & N 1 1

%%5 ZIP   5 # O N # 4 0 5

HP2XRX AND DOCUTAG

6-4 ELIXIR TECHNOLOGIES CORPORATION



Using fonts with DocuTag

If you plan to use fonts other than those supported by
HP2XRX, you must create both Elixir screen and
Xerox centralized printer versions of the fonts.  You
must also create a kerning table for the font used by
HP2XRX when your document converts.

For details on how to create the kerning table needed
by HP2XRX, see the HP2XRX User Guide.

Adding BPSD tags to Documents

There are two ways to add BPSD tags to your
document:

add BPSD tag position markers in your applica-
tion before conversion to ElixiForm

add BPSD tags after conversion in ElixiForm

Adding  BPSD tag position markers in your application

To denote where a BPSD tag begins in your source
document, you must insert a tag position marker
(%%n).

The BPSD tag field number following the percent
signs, represented by n, may be any number from 1 to
748.  The field number must directly follow the two
percent signs.

BPSD tag position marker considerations

In order to detect BPSD tag position marker locations,
HP2XRX expects the %%n tag position markers to be
contiguous strings in the .HP print file.  To ensure
HP2XRX identification of the tags, a tag position
marker must be a left justified text item  a justified
text item in a paragraph.  Example:  in Ventura Pub-
lisher, the Letter Spacing option set to [OFF].
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Make an appropriate amount of space available in the
source document to accommodate the variable data
associated with a BPSD tag position marker.

You can ensure that the space is available by posi-
tioning tags on their own line, or by using spacing
characters, tabs, or frames to occupy the desired
amount of white space immediately following the tag.
BPSD tag replacement characters will not wrap from
one line to the next.  Variable data position starting at
the location of the first % sign of the %%n tag marker.

Adding BPSD tags in ElixiForm

You can post-process HP2XRX-generated Elixir form
files using ElixiForm.  This method allows insertion of
BPSD tags in WYSIWYG mode.  You can also use
ElixiForm to assign tag attributes to each tag position
marker.  See the "ElixiForm and DocuTag" chapter.

Creating Elixir form files from HP documents

After you create your document, print the document to
disk with the printer output option set to HP LJ II, 300
dpi.  This produces a disk print file with a file exten-
sion of .HP.  You can then use HP2XRX and DocuTag
in the Elixir/ElixiSys Desktop to convert the document
to normalized metacode format.

To convert your document to an Elixir format file:

1. Copy the .HP file from the HP PCL folder in
the Input Documents folder to the Converter
icon.

The Document Converter Options dialog box
displays.
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    Figure 6-7.  Document Converter Options 
dialog box

2. Select  [Elixir] as the output format and click
on [OK].

The VP297/HP2XRX Converter Options dialog box
displays.

             Figure 6-8.  VP297/HP2XRX Converter Options 
      dialog box

This dialog box allows you to specify parameters for
running HP2XRX conversion program.  For more in-
formation, see the HP2XRX User Guide.

Other options in this dialog box are grayed-out and/or
do not apply to this conversion.
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DJDE Entry
The Dynamic Job Descriptor Entry coded for the PRE-
FIX statement in your printer ELIXIR.JSL file, or the
default JSL if printing online files.  See the HP2XRX
User Guide for more information.

X and Y shift
The number of dots you want the pages of the output
file shifted in the X and Y directions.

External HP Font file
This file must contain all of the fonts you need.  If you
use this option, set [Generate Fonts] to No.

Copies
The number of copies to print.

Output to
Select [Disk] or [Tape] as your output medium.

Output Pages as
Applicable for Xerox production (9700) output only.
Select [Simplex] (one-sided) or [Duplex] (two-sided).

Clean Up Files
Select this option to create a command file to delete
the files used for the job.

Format Graphics as
Converts graphics to images [IMGs] or fonts [Fonts]
format.  See the HP2XRX User Guide for more
information.

Compress IMG Graphics as
For .IMG image files, [Partial] compresses duplicate
lines and blank (null) lines, [Full] compresses dupli-
cate lines, blank lines, and optimizes for white space.
[None] does not compress files.

Use [None] if you want to use PageHandler after
conversion.

Elixir Documents
The default directory for Elixir Document Lists is
drive:\ELIXIR\DOCS\DOCLIST.

3. Click on [OK].

The Extra Converter Options dialog box displays.
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         Figure 6-9.  Extra Converter Options dialog box

Color Output
[None] is the default.  Other options in this dialog box
are grayed-out and do not apply to this conversion.

4. Click on [OK].

 The Elixir Exec dialog box displays.

The Elixir Exec dialog box

Once conversion begins, the Elixir Exec dialog box
displays conversion progress and error or warning
information.

Conversion progress

Conversion progress displays in the middle of the dia-
log box.  When conversion is complete and free of er-
rors, the Elixir Exec dialog box prompts you to "Press
any key to continue...".  Press a key.

Your file is now in Elixir format.  See the "ElixiForm
and DocuTag" chapter for details on adding or defin-
ing BPSD tags.

Error and Warning messages

Once conversion is complete, if there are any error or
warning messages, they display under the heading: 

Desktop Reports ERROR or WARNING in DocuTag Converter.

Make corrections and re-convert until no errors or
warnings display.
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Proof-printing your document

Using ElixiForm, you can proof print the series of
forms created by HP2XRX on a PC-attached laser
printer.

Converting form lists in DocuTag

Before converting Elixir form files that only contain tag
position markers, you need to assign attributes to
each tag position marker.  For details on performing
this operation and converting your files to normalized
metacode format, see the "ElixiForm and DocuTag"
chapter.
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7. Transferring files
 to the host

This chapter describes the procedures and the vari-
ous conversion processes needed for transferring nor-
malized metacode files from your PC to the host.

      Figure 7-1.  Work flow uploading to the host
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Transferring normalized metacode files to the
DocuMerge EDL

After DocuTag generates a normalized metacode file,
there are two procedures you need to be perform be-
fore you can load the normalized metacode EDL
member into an EDL:

1. Transfer the DocuTag generated normalized
metacode file to the host computer.

2. Convert the normalized metacode file to a
VBM format file on the host.

Transferring normalized metacode to the host

To successfully transfer normalized metacode files,
you must have a file transfer package, such as DCA's
IRMA card with FT/TSO, IRMA FT/3270, or IBM 3270.

Transferring files to the host using IRMA FT/3270 or IBM 3270

When uploading normalized metacode to the EDL us-
ing IRMA FT/3270 or IBM 3270, you must first pre-
allocate (partition) two datasets as follows:

SYSUT1 DD dataset partitioning

Pre-allocate the SYSUT1 DD dataset input to the
IEBGENER reformatting step as:

Specification Parameter

Block size  540
Record length  540
Record format  FB

SYSUT2 DD dataset partitioning

Pre-allocate the SYSUT2 DD dataset output from the
IEBGENER reformatting step as:
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Specification Parameter

Block size  540
Record length  536
Record format  VBM

Transferring files to the host using IRMA FT/TSO

When uploading normalized metacode to the EDL us-
ing IRMA FT/TSO, you must first pre-allocate (parti-
tion) two datasets as follows:

SYSUT1 DD dataset partitioning

Pre-allocate the SYSUT1 DD dataset input to the
IEBGENER reformatting step as:

Specification Parameter

Block size  540
Record length  540
Record format  FB

SYSUT2 DD dataset partitioning

Pre-allocate the SYSUT2 DD dataset output from the
IEBGENER reformatting step as:

Specification Parameter

Block size  540
Record length  536
Record format  FBM

The FT/TSO package permits the user to specify a BI-
NARY transfer mode along with a record length of 540
bytes, a blocksize of 540 bytes, and a RECFM (record
format) of FB (fixed-blocked).  Specify each of these
parameters to ensure no corruption in the file during
the transfer process.

FT/TSO transfer specifications

The transfer parameters required for FT/TSO are as
follows:
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Block size: 540

Record size: 540

Record format: Fixed Blocked

Line numbers: Position: 0 Length: 0

Code table: STD

Transfer mode: BINARY

Expand tabs: NO

Truncate spaces: NO

U/L case: ASIS

Space units: TRKS

Primary QTY: 2

Secondary QTY: 2

IRMA FT/3270 and IBM 3270 transfer specifications

After pre-allocating the SYSUT1 and SYSUT2 data-
sets for the IEBGENER reformatting step,  issue the
following command from the DOS command line:

SEND pcfilename hostfilename

The normalized metacode file referenced by pcfile-
name uploads into the dataset specified by the
hostfilename.

Configure your transfer package to disallow ASCII to
EBCDIC translation.  Do not perform carriage
return/line feed (CRLF) record separation between re-
cords of the normalized metacode file.  For further de-
tails on your file transfer package, see the
documentation supplied with your file transfer
software.
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Converting normalized metacode to VBM
format

After the normalized metacode file moves to the host
environment, you must convert the file from FB (fixed-
blocked) format to the VBM (variable blocked ma-
chine) format that the DocuMerge utility (VLMUTIL or
VLMMAINT IEBGENER) needs.

Although the file uploads to the host as a fixed-
blocked file, the IEBGENER JCL tells the system
catalog to view the dataset as a VBM file by specifying
a VBM record format on both the SYSUT1 and
SYSUT2 steps of the IEBGENER reformatting step.

No individual metacode record in the normalized
metacode file should exceed the 255 byte maximum
record length allowed by DocuMerge.

A sample JCL for submitting metacode to the printer
follows:

//O0D42DA JOB (8200,Z200-Z20001), 7-1994',CLASS=A,
//MSGCLASS=J,NOTIFY=00D42D,USER=00D42D,PRTY=4
/* JOBPARM L=9999
//*
//* JCL TO CONVERT NORM. META TO VBM FORMAT
//*
//XRX9700 OUTPUT DEST=R269
//STEP1 EXEC PGM=IEBGENER
//SYSPRINT DD SYSOUT=*
//SYSUT1 DD UNIT=DISK,DISP=OLD,
//DSN=O0D42D.0Z200.NORM.MET.DATA,
//DCB=(LRECL=536,BLKSIZE=540,RECFM=VBM)
//SYSUT2 DD UNIT=DISK,DISP=NEW,
//DSN=O0D42D.OZ200.NORMOUT.MET.DATA,
//DCB=(LRECL=536,BLKSIZE=540,RECFM=VBM)
//*

Use the DCB parameters for both the input (SYSUT1)
and output (SYSUT2) parameters in the IEBGENER
JCL (even though you partitioned the SYSUT2 dataset
differently).

Specifying the DCB parameters causes the MVS sys-
tem catalog to view the online metacode dataset as a
VBM file instead of as an FB file, which was the re-
cord format specified when the file uploaded.  
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The IEBGENER utility then treats the dataset as a
VBM file and sends each variable length record within
the file to the printer.

Note: You can convert DocuTag-produced normalized
metacode to VBM format on host computers with op-
erating environments other than MVS.  You can deter-
mine the correct upload procedure for your
environment, as well as a means of converting the file
into a true VBM format file.

In VM and DOS environments, you must write your
own EXEC or equivalent utility to extract each variable
length metacode record from the 540 byte blocks of
metacode records contained within the normalized
metacode dataset.

Normalized metacode file format

The fixed-blocked normalized metacode file has the
following format for each 540 byte block:

Bytes 0 to 3:  Block length (hex).

Bytes 4 to 7:  Length of first metacode record (hex).

Bytes 8 to n:  First metacode record, where n equals
7 plus the length specified in bytes 4 to 7.

Bytes n + 1 to 540:  The remainder of each 540 byte
block consists of a series of four byte record descrip-
tor words followed by a corresponding metacode
record.

The record descriptor words specify the length of each
metacode record.  You can pad the end of each 540
byte block with hex zeroes.

TRANSFERRING FILES TO THE HOST

7-6 ELIXIR TECHNOLOGIES CORPORATION



Using VLMUTIL or VLMMAINT to load the EDL

Once you convert the normalized metacode file to
VBM format, insert the file into the DocuMerge EDL
using the VLMUTIL or VLMMAINT LOAD utility.  See
the DocuMerge Reference Guide  for more informa-
tion about the VLMUTIL and VLMMAINT LOAD
utilities.
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8. Extracting files 
from the host

This chapter describes the various processes for ex-
tracting and transferring normalized metacode files
from the host to your PC.

Figure 8-1.  Work flow extracting from the host
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File transfer packages and the Elixir utility, MET2ELX,
work with ElixiForm and the Elixir Desktop to facilitate
the downloading process.

Importing EDL members into ElixiForm

Before you can view or edit existing DocuMerge EDL
members in ElixiForm, you must first convert them
into Elixir form (.ELX) files.

To convert and download existing EDL members into
ElixiForm:

1. Locate all fonts used in the DocuMerge
normalized metacode files and download
them to your PC.  Convert the fonts to Elixir
screen format using ElixiSys.

2. Determine which variety of file transfer
package you are using: IBM 3270, IRMA
FT/3270, or IRMA FT/TSO.

If you are using IBM 3270 or IRMA FT/3270, extract
the normalized metacode file from your VLAM library
and convert it to a U-format (unformatted) file on the
host.

If you are using IRMA FT/TSO, extract the normalized
metacode file from your VLAM library and specify that
it be placed in FBM format (fixed-blocked machine)
file on the host.

3. If the file you downloaded is an unformatted
file, convert the normalized metacode files
into the Elixir format using the Elixir MET2ELX
utility.
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Note:  If the file is a fixed blocked machine file,
specify the FIXED record format option when you
convert the file into Elixir format using the
MET2ELX utility.

or

Use the Elixir Desktop to convert normalized
metacode files into Elixir format (see the ElixiSys
Desktop  User Guide).

Details on each of these steps follow.

Retrieving and converting fonts

You can move the fonts used in your normalized
metacode documents to your PC in three ways:

PC-to-mainframe link
PC tape unit
Xerox centralized printer floppy disk utility

PC-to-mainframe link

To transfer font files successfully using a PC-to-
mainframe link, use a file transfer package such as
the IBM 3270 package or the IRMA FT/3270.  These
packages allow you to transfer files in a binary mode
to and from host datasets.  Store Font, compiled form
(FRM), and logo (LGO) files in host datasets with a re-
cord length and block size of 128 bytes and in fixed-
blocked record format (FB).

You should move all Xerox centralized printer font
files to the \ELIXIR\FONTS\X97IN directory once on
the PC.  This is the directory in which the Elixir Desk-
top looks for files to convert to Elixir screen format.

Note: If you are using the PC tape unit supported by
the Elixir Desktop, follow the procedures described in
the ElixiSys Desktop User Guide.
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Converting font files to Elixir screen format

Use the Elixir Desktop to convert the Xerox central-
ized printer format font files to Elixir screen font format
(see the ElixiSys Desktop User Guide).

Repeat the process until you convert all required files.
Select [Cancel] on the Item Selector menu to end the
font conversion process.

Note: You must convert the fonts referenced within
the normalized metacode files to Elixir screen format
before converting the normalized metacode files to the
Elixir form format.

Extracting, converting, and downloading files
from the EDL 

The following sections describe file transfer
procedures.

Note:  VLAM1 is no longer supported by DocuMerge.

Extracting files using IRMA FT/3270 or IBM 3270

If you are using the IRMA FT/3270 or the IBM 3270
file transfer package, you can download your EDL
members from the host as U-format files.  These files
are smaller and more efficient to transfer than the FB
format files used with IRMA FT/TSO.

Dataset partitioning using IRMA FT/3270 or IBM 3270

When extracting normalized metacode from the EDL
using IRMA FT/3270 or IBM 3270, you must first pre-
allocate (partition) two datasets as follows:

OUTPUT DD dataset partitioning

Pre-allocate the OUTPUT DD dataset from the
VLMMAINT DUMP step as:  
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Specification Parameter

Block size 3000
Record length  155
Record format  VB

SYSUT2 DD dataset partitioning

Pre-allocate the SYSUT2 DD dataset from the
IEBCOPY reformatting step as:

Specification Parameter

Block size 3000
Record length 3000
Record format   U

To extract the normalized metacode file from the EDL,
use Image Sciences' VLMMAINT DUMP utility to en-
able transfer with one of the packages mentioned
above.

Extract JCL for VLAM2

//*********************************************************
//**THIS JCL DOWNLOADS FORMS ON A VLAM2 LIBRARY TO *
//**A SEQUENTIAL FILE *
//*********************************************************
//JOBNMEPM JOB (57000G,FSIC,FBC000,JD1550,43100),
// 'DOWNLOAD EDLTOELX'.
//MSGLEVEL=1,TIME=10,PRTY=14,MSGCLASS=A,
// NOTIFY=EMPID
//*EXEC CNTR2
//*MAIN ORG=IS,USER=EMPID,CLASS=CICS29
//*FORMAT PR,DNAME=,DEST=OUTPUT1
//FREESPAC EXEC PGM=DUMMYJOB
//NORMOT DD DSN=B57.DL75717.NORMOT,
// DISP=(OLD,DELETE,DELETE)
///*********************************************************

//**THIS STEP COPIES A FORM FROM THE EDL TO A * 
//**SEQUENTIAL DATASET *
//*********************************************************
//*
//VLAM2 EXEC PGM=VLMMAINT
//STEPLIB DD DSN=B57.DOCUMERG.JOBLIB,DISP=SHR
//*
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//* *****************************************************
//* ** CHANGE FOLLOWING VLAMLIB TO THE 
//* ** CORRECT ONE NEEDED 
//* *****************************************************
//*
//VLM2LIB DD
DSN=57V.INDX1.00CMG.EDLTYPE1,
// DOCLIB.DISP=SHR
//*
//SYSUDUMP DD SYSOUT=*
//SYSPRINT DD SYSOUT=*
//OUTPUT    DD DSN=B57.DL75717.NORMALOT,
// DISP=SHR
//DCB=(RECFM=VB,LRECL=155,BLKSIZE=3000)
//MESSAGE DD SYSOUT=*,
DCB=(RECFM=FB,LRECL=133,BLKSIZE=23408)
//LISTING DD SYSOUT=*,
DCB=(RECFM=FB,LRECL=133,BLKSIZE=23408)
//REPORT DD SYSOUT=*,
DCB=(RECFM=FB,LRECL=133,BLKSIZE=23408)
//INPUT DD DUMMY
//SYSIN DD *
-
- **************************************************
- * KEY THE FORM NUMBER (OR NAME) BELOW *
- **************************************************
DUMP MEMBER='FORMS1' -

OUTDD=OUTPUT -
CHAIN=META -
LIBDD=VLM2LIB

-
/*
//* ***********************************************************
//* * THIS IEBCOPY STEP TAKES THE SEQUENTIAL FILE
THAT*
//* * WAS CREATED IN THE PREVIOUS STEP AND CHANGES *
//* * THE DCB SO THAT IT CAN BE DOWNLOADED TO THE PC
*
//* * AND USED WITH ELIXIR *
//* ***********************************************************
//REFORMT EXEC PGM=IEBCOPY
//SYSPRINT DD SYSOUT=*
//SYSUT1 DD
DSN=B57.DL75717.NORMALOT,
//DISP=SHR,
//DCB=(RECFM=U,BLKSIZE=3000)
//SYSUT2 DD
DSN=B57.DL75717.NORMOT,
//DCB=(RECFM=U,LRECL=3000,BLKSIZE=3000)
// UNIT=DISK,VOL=SER=857JDI,
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// DISP=(.CATLG,DELETE),
// SPACE=(CVL,(2,1),RLSE),
//
//*

IEBCOPY conversion to U-format

After you extract a file, convert it into an unformatted
(U-format) file to facilitate downloading to the PC.  In
an MVS environment, convert using the IEBCOPY
utility.

Converting your normalized metacode file to an unfor-
matted file creates a small file for host transfer. Spec-
ify the same DSN (data set name) parameter for the
IEBCOPY SYSUT1 (input) step as you specified in the
OUTPUT DD for the VLMMAINT DUMP operation.

The DCB for the IEBCOPY SYSUT1 (input) step
should specify a record format of U and a block size
of 3000.  Specify no record length in the SYSUT1
DCB.  The DCB for the IEBCOPY SYSUT2 (output)
step should be identical, but with the additional specifi-
cation of a record length of 3000.

For example, code the SYSUT1 DCB of the IEBCOPY
JCL as follows:

DCB=(BLKSIZE=3000,RECFM=U)

Code the SYSUT2 DCB of the IEBCOPY JCL as
follows:

DCB=(LRECL=3000,BLKSIZE=3000,RECFM=U)

Downloading U-format metacode files to the PC

To download U-format files using either IBM 3270 or
IRMA FT/3270 file transfer packages, you must con-
figure your package to transfer files in a binary mode
(so that no EBCDIC to ASCII translation takes place
when the file transfers).  You should also NOT specify
that the records of the file are carriage return/line feed
(CRLF) delimited.  You may need to consult your PC
support personnel to be certain that your transfer
package configuration is correct.
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To download your file, issue the following commands
from the DOS command line:

RECEIVE pcfilename hostfilename

This downloads the normalized metacode file refer-
enced by hostfilename into the dataset denoted by the
pcfilename.

Naming normalized metacode files (3270) 

Place the extracted normalized metacode files in the
\ELIXIR\DOCS\NRMETIN directory.

File re-naming during conversion
As an example, a three-page normalized metacode
file named POLICY.MET upon conversion becomes
POLICY.ELX, POLIC2.ELX, and POLIC3.ELX.

Note: When naming files, be sure to avoid the three
position names that are DOS reserved, such as CON
(console) or PRN (printer).  Also, when converting
multiple page files, avoid file names ending with a nu-
meric (such as A332, P273, etc.)  File names ending
in a numeric can overwrite page one with page two,
page two with page three, etc.

Extracting files using IRMA FT/TSO 

FT/TSO cannot transfer U-format files from the host to
the PC.  If you use FT/TSO to extract EDL members
from the host and work with them in ElixiForm, you
must use Image Sciences' VLMMAINT DUMP utility to
extract members from the EDL.

Dataset partitioning using IRMA FT/TSO

When extracting normalized metacode from the EDL
using IRMA FT/TSO, you must first pre-allocate (parti-
tion) two datasets as follows:

OUTPUT DD dataset partitioning

Pre-allocate the OUTPUT DD dataset from the
VLMMAINT DUMP step as:
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Specification Parameter

Block size 1500
Record length  150
Record format  FBM

SYSUT2 DD dataset partitioning

Pre-allocate the SYSUT2 DD dataset from the
IEBCOPY reformatting step as:

Specification Parameter

Block size 1500
Record length  150
Record format   FB

The JCL for extracting EDL members downloaded
with FT/TSO is the same as that of IRMA FT/3270
and IBM 3270 except for the following DCB parameter
modifications.

The DCB parameters on the OUTPUT DD of the
VLMMAINT DUMP step should read as follows: 

(RECFM=FBM,LRECL=150,BLKSIZE=1500)

Converting to FB format using IEBCOPY

Once you extract a file, convert it into a fixed-blocked
(FB) format file to facilitate downloading to the PC.  In
an MVS environment, convert the file using the
IEBCOPY utility.

Converting your normalized metacode file to a fixed-
blocked file facilitates transfer with FT/TSO.  Specify
the same DSN (data set name) parameter for the
IEBCOPY SYSUT1 (input) step as you specified in the
OUTPUT DD for the VLMMAINT DUMP operation.

The DCB for the IEBCOPY SYSUT1 (input) step
should specify a record format of FB and a block size
of 1500.  Specify no record length in the SYSUT1
DCB.  The DCB for the IEBCOPY SYSUT2 (output)
step should be identical, but with the additional specifi-
cation of a record length of 150.

EXTRACTING FILES FROM THE HOST
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For example, code the SYSUT1 DCB of the IEBCOPY
JCL as follows:

DCB=(BLKSIZE=1500,RECFM=FB)

Code the SYSUT2 DCB of the IEBCOPY JCL as
follows:

DCB=(LRECL=150,BLKSIZE=1500,RECFM=FB)

Naming normalized metacode files (FT/TSO)

Place the extracted normalized metacode files in the
\ELIXIR\DOCS\NRMETIN directory.

File re-naming during conversion
As an example, a three-page normalized metacode
file named POLICY.MET upon conversion becomes
POLICY.ELX, POLIC2.ELX, and POLIC3.ELX.

Note: When naming files, be sure to avoid the three
position names that are DOS reserved, such as CON
(console) or PRN (printer).  Also, when converting
multiple page files, avoid file names ending with a nu-
meric (such as A332, P273, etc.).  File names ending
in a numeric can overwrite page one with page two,
page two with page three, etc.

Converting EDL members to Elixir ELX format

Use the MET2ELX utility or the Elixir Desktop  to con-
vert the EDL members you download from the host
into Elixir format.  When you type MET2ELX <Enter>
from the DOS prompt while in the \ELIXIR directory, a
screen message displays all the parameter options
you can specify when you invoke MET2ELX.

EXTRACTING FILES FROM THE HOST

8-10 ELIXIR TECHNOLOGIES CORPORATION



Figure 8-2.  MET2ELX parameter listing

The parameter options include file name, page orien-
tation, page size, monitor type, and record format.  If
you downloaded U-format EDL members from the
host using IBM 3270 file transfer or IRMA FT/3270,
MET2ELX treats these files as VB (variable blocked)
format files.  That is because the U-format file con-
tains the record and block descriptor words contained
in a standard VB format file.  VB is the default record
format for MET2ELX.

A description of the MET2ELX utility follows.

Using MET2ELX

The MET2ELX utility converts a normalized metacode
file to .ELX (Elixir) format.  It creates one .ELX file for
every page in the metacode file.

Usage

MET2ELX filename [AUTO | PORT | LAND] [LETTER
| A4 | 14 | 17 | A3] [MONITOR]  [V#### | F####] [NO-
EXT | EXT | FRM] [FONTLIST] [DJDELENGTH]
<Enter>

filename
Use any DOS file name, including file extension (wild-
cards are acceptable).

AUTO | PORT | LAND 
Specify a portrait or landscape metacode document,
or specify AUTO for automatic orientation.

EXTRACTING FILES FROM THE HOST
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LETTER | A4 | 14 | 17 | A3
Specify the page size.

MONITOR
Options are NONE, VGA, SIGMA, WYSE and SU-
PERVGA.  The monitor type you specify determines
the resolution of the screen graphics built by
MET2ELX if any graphics are in the metacode.
NONE does not create a screen graphics.

V#### | F####
Specify a variable or fixed block format and optional
blocklength.

V#### is not valid for PageHandler.  If you have meta-
code files that need converting using  V#####, see the
Elixir Desktop User Guide or the ElixiForm User
Guide.

MET2ELX also accepts files with fixed-length,
150-byte metacode records.  If the metacode records
are not all exactly 150 bytes long, pad these records
with low values (hex 00) or spaces (hex 20).

MET2ELX creates a form list file for the converted
document in the \ELIXIR\DOCS\DOCLIST directory.

NOEXT | EXT | FRM
Specifies what type of file you generate (.ELX or
.FRM), as well as the associated page numbering
convention.  For .ELX files, you have the option of cre-
ating your own extension.

NOEXT
generates an .ELX file, with the page numbering
embedded in the stem

EXT
generates an .ELX file, but you specify the exten-
sion used for numbering

FRM
specifies files converted to .FRM, with each
printed page being a compiled Xerox .FRM file

FONTLIST
Specify an external PDE font list (stem name only).

EXTRACTING FILES FROM THE HOST
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DJDELENGTH
Specify the length of the offset DJDE prefix string.

Directory information

You must run MET2ELX from the directory in which
input files reside.  If you have not specified \ELIXIR in
your DOS PATH= statement, precede the MET2ELX
command with \ELIXIR.

.ELX files created by MET2ELX write to the default
forms directory as specified in the ElixiForm [Filing
Options] of the System menu.

MET2ELX uses the following naming conventions
when converting multi-page documents:

The name for the first page of a converted file re-
tains the first eight characters of the source file
name.  If the source file name has less than eight
characters, it retains all characters.

For pages 2 through 9, digits 2 through 9 replace
the right character of the output file name.  For
pages 10 through 99, digits 10 through 99 replace
the two right characters of the output file name.  A
similar naming convention applies to pages 100
through 999.  MET2ELX supports only documents
up to 999 pages long.

If the metacode contains graphics, MET2ELX creates
Elixir-format (.LP3) graphics files in the \ELIXIR\PIC-
S\PRINTER directory.  The stem names of the Elixir
format files are the internal names stored in each
graphics.

MET2ELX file conversion example

To convert a three-page normalized metacode file,
MYFORM.MET in the \ELIXIR\DOCS\NRMETIN direc-
tory to Elixir-format (.ELX) files, type:  

EXTRACTING FILES FROM THE HOST
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1. CD \ELIXIR\DOCS\NRMETIN <Enter>.  This
changes the current directory to
\ELIXIR\DOCS\NRMETIN (the normalized
metacode file location).

2. \ELIXIR\MET2ELX MYFORM.MET PORT
LETTER WYSE VB  <Enter>

If the normalized metacode file included three
.IMG format graphics, the resulting graphics files
reflect the name stored in each .IMG graphics
and write to the \ELIXIR\PICS\PRINTER
directory.

The form list file produced by the conversion
(MYFORM.DAT) writes to the \ELIXIR\DOCS\DO-
CLIST directory.

Converting U-format EDL members 

When converting U-format normalized metacode EDL
members to Elixir files, you can omit the V parameter
as it is the default.  For example:

\ELIXIR\MET2ELX FILENAME PORT 14 WYSE NO-
EXT FONTLIST DJDELENGTH  <Enter>

where FILENAME is the name of a normalized meta-
code file.  The MET2ELX utility creates one Elixir file
for each individual page in the normalized metacode
file.

Converting FB format EDL members 

When converting FB format normalized metacode
EDL members to Elixir-format files, include the F pa-
rameter.  For example, 

\ELIXIR\MET2ELX FILENAME LAND A4 WYSE F
NOEXT FONTLIST DJDELENGTH <Enter>\

where FILENAME is the name of a normalized meta-
code file.   The MET2ELX utility creates one Elixir file
for each individual page in the normalized metacode
file.

EXTRACTING FILES FROM THE HOST
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Generating form lists with MET2ELX

The MET2ELX utility keeps track of the individual
pages in your normalized metacode files by creating a
form list file for each single or multi-page EDL mem-
ber that processes.  The form list files write to the
\ELIXIR\DOCS\DOCLIST directory.  DocuTag uses
the form list file to re-assemble the multi-page docu-
ment when you convert it back to normalized meta-
code format.

Viewing or editing EDL members

To view or edit EDL members after converting them to
Elixir form format, start ElixiForm and load the form or
sequence of forms that comprise the EDL member.
(See the ElixiForm User Guide for complete instruc-
tions on using ElixiForm.) 

EXTRACTING FILES FROM THE HOST
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A. Transferring font files
between the host and PC

For the MET2ELX utility to convert your normalized
metacode file correctly, convert all fonts to Elixir
screen format prior to invoking MET2ELX conversion.

Transferring fonts with IBM 3270 or IRMA
FT/3270

You may use the IBM 3270 or the IRMA FT/3270 file
transfer package to upload or download font files, but
configure them to transfer files in a binary mode (no
EBCDIC to ASCII translation takes place when the file
transfers).  You should also NOT specify that the re-
cords of the file are carriage return/line feed delimited.
You may need to consult your PC support personnel
to be certain that your transfer package configuration
is correct.

To download a font file, issue the following command
from the DOS command line:

RECEIVE pcfilename hostfilename

This downloads the font file referenced by hostfile-
name into the dataset denoted by the pcfilename.

To send a font file to the host, issue the following
command from the DOS command line:

SEND pcfilename hostfilename

This stores the font file referenced by the pcfilename
in the host dataset denoted by the hostfilename.
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Note:  Before you send a font file back to the host by
using one of the 3270 emulation packages, be certain
that you have pre-allocated a dataset on the host with
the following DCB specifications:

DCB=(LRECL=128,BLKSIZE=128,RECFM=FB)

Transferring font files with FT/TSO

Use the following file transfer specifications to upload
and download font files in a host MVS computing envi-
ronment.  Use DCA's FT/TSO version 1.1 (both the
host and PC portions of this package are version 1.1)
and IRMA card to perform the file transfer.

The transfer parameters required are as follows:

Block size: 128

Record size: 128

Record format: FB

Line numbers: Position: 0 Length: 0

Code table: STD

Transfer mode: BINARY

Expand tabs: NO

Truncate spaces: NO

U/L case: ASIS

Space units: TRKS

Primary QTY: 2

Secondary QTY:  2

VP297 AND HP2XRX COMPATIBILITY
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B. VP297 and HP2XRX
compatibility

This appendix contains information about upgrading to
the PrintDriver from VP297 or HP2XRX.

HP2XRX

The PrintDriver allows you to use TrueType, ATM, or
Xerox fonts in  documents you create.

At this time, the PrintDriver does not support Bit-
stream fonts.  If you want to use the PrintDriver with
existing documents containing Bitstream fonts, you
must change all Bitstream fonts to TrueType, ATM, or
Xerox fonts.

VP297

The PrintDriver allows you to create new documents
using TrueType, ATM, or Xerox fonts.   If you want to
use the PrintDriver with existing documents that con-
tain Swiss, Dutch, Courier or Symbol fonts, use the
font mapping table described in the Elixir PrintDriver
User Guide to map your existing fonts to Xerox fonts.

The following table shows the font mapping for VP297
fonts that installs during installation:
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%%Elixir_Font-Services-Table: 1.0 September 1993

%keyidx,DOSFILE, Logical Internal name,External TypeFace name,
%LSize,PtSize,Bold,ItalObq,Weight, Width,Dir,Rot,FontName

%-----------------------------------------------------------------------------------------

fmap=0,None,Swiss,None,None,8,None,None,Med,None,0,P,5PH08N;  

fmap=1,None,Dutch,None,None,12,None,None,Bold,None,0,P,5PT12B;

fmap=2,None,Swiss,None,None,10,None,None,Bold,None,0,P,5PH10B; 

fmap=3,None,Swiss,None,None,12,None,None,Bold,None,0,P,5PH12B; 

fmap=4,None,Swiss,None,None,18,None,None,Bold,None,0,P,1PH18B; 

fmap=5,None,Swiss,None,None,24,None,None,Bold,None,0,P,1PH24B; 

fmap=6,None,Dutch,None,None,18,None,None,Bold,None,0,P,1PT18B; 

fmap=7,None,Dutch,None,None,24,None,None,Bold,None,0,P,1PT24B; 

fmap=8,None,Swiss,None,None,18,None,None,Bold,None,0,P,2PH18B; 

fmap=9,None,Swiss,None,None,24,None,None,Bold,None,0,P,2PH24B; 

fmap=10,None,Dutch,None,None,18,None,None,Bold,None,0,P,2PT18B; 

fmap=11,None,Dutch,None,None,24,None,None,Bold,None,0,P,2PT24B; 

fmap=12,None,Swiss,None,None,24,None,None,Bold,None,0,P,3PH24B;

fmap=13,None,Dutch,None,None,24,None,None,Bold,None,0,P,3PT24B; 

fmap=14,None,Courier,None,None,10,None,None,Med,None,0,P,TAN10P;

fmap=15,None,Courier,None,None,12,None,None,Med,None,0,P,TAN12P;

fmap=16,None,Swiss,None,None,6,None,None,Med,None,0,P,5PH06N; 

fmap=17,None,Swiss,None,None,12,None,None,Med,None,0,P,5PH12N; 

fmap=18,None,Swiss,None,None,10,None,Ital,Med,None,0,P,5PH10I; 

fmap=19,None,Swiss,None,None,10,None,None,Med,None,0,P,5PH10N;

 fmap=20,None,Swiss,None,None,12,None,Ital,Med,None,0,P,5PH12I; 
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fmap=21,None,Dutch,None,None,10,None,Ital,Med,None,0,P,5PH10I;   

fmap=22,None,Swiss,None,None,14,None,None,Bold,None,0,P,5PH14B; 

fmap=23,None,Symbol,None,None,10,None,None,Med,None,0,P,5PM10N;

fmap=24,None,Dutch,None,None,8,None,None,Med,None,0,P,5PT08N; 

fmap=25,None,Dutch,None,None,10,None,None,Bold,None,0,P,5PT10B; 

fmap=26,None,Dutch,None,None,10,None,None,Med,None,0,P,5PT10N; 

fmap=27,None,Dutch,None,None,12,None,Ital,Bold,None,0,P,5PT12I; 

fmap=28,None,Dutch,None,None,12,None,None,Med,None,0,P,5PT12N; 

fmap=29,None,Dutch,None,None,14,None,None,Bold,None,0,P,5PT14B; 

fmap=30,None,Swiss,None,None,8,None,None,Med,None,0,L,5LH08N;

fmap=31,None,Dutch,None,None,12,None,None,Bold,None,0,L,5LT12B;

fmap=32,None,Swiss,None,None,10,None,None,Bold,None,0,L,5LH10B; 

fmap=33,None,Swiss,None,None,12,None,None,Bold,None,0,L,5LH12B; 

fmap=34,None,Swiss,None,None,18,None,None,Bold,None,0,L,1LH18B; 

fmap=35,None,Swiss,None,None,24,None,None,Bold,None,0,L,1LH24B; 

fmap=36,None,Dutch,None,None,18,None,None,Bold,None,0,L,1LT18B; 

fmap=37,None,Dutch,None,None,24,None,None,Bold,None,0,L,1LT24B; 

fmap=38,None,Swiss,None,None,18,None,None,Bold,None,0,L,2LH18B; 

fmap=39,None,Swiss,None,None,24,None,None,Bold,None,0,L,2LH24B; 

fmap=40,None,Dutch,None,None,18,None,None,Bold,None,0,L,2LT18B; 

fmap=41,None,Dutch,None,None,24,None,None,Bold,None,0,L,2LT24B; 

fmap=42,None,Swiss,None,None,24,None,None,Bold,None,0,L,3LH24B;

fmap=43,None,Dutch,None,None,24,None,None,Bold,None,0,L,3LT24B; 

fmap=44,None,Courier,None,None,10,None,None,Med,None,0,L,XCP10L; 

fmap=45,None,Courier,None,None,12,None,None,Med,None,0,L,XCP12L;
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fmap=46,None,Swiss,None,None,6,None,None,Med,None,0,L,5LH06N; 

fmap=47,None,Swiss,None,None,12,None,None,Med,None,0,L,5LH12N; 

fmap=48,None,Swiss,None,None,10,None,Ital,Med,None,0,L,5LH10I; 

fmap=49,None,Swiss,None,None,10,None,None,Med,None,0,L,5LH10N; 

fmap=50,None,Swiss,None,None,12,None,Ital,Med,None,0,L,5LH12I; 

fmap=51,None,Dutch,None,None,10,None,Ital,Med,None,0,L,5LH10I;   

fmap=52,None,Swiss,None,None,14,None,None,Bold,None,0,L,5LH14B; 

fmap=53,None,Symbol,None,None,10,None,None,Med,None,0,L,5LM10N; 

fmap=54,None,Dutch,None,None,8,None,None,Med,None,0,L,5LT08N; 

fmap=55,None,Dutch,None,None,10,None,None,Bold,None,0,L,5LT10B; 

fmap=56,None,Dutch,None,None,10,None,None,Med,None,0,L,5LT10N; 

fmap=57,None,Dutch,None,None,12,None,Ital,Med,None,0,L,5LT12I; 

fmap=58,None,Dutch,None,None,12,None,None,Med,None,0,L,5LT12N; 

fmap=59,None,Dutch,None,None,14,None,None,Bold,None,0,L,5LT14B; 
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Glossary

This glossary contains a basic list of the terminology
used in this guide.

application
Any program you run on your PC.  Icons represent
Elixir applications on the Elixir Desktop.  If you did not
install the Elixir application on your PC, its icon does
not display.

arrow 
The screen pointer used for selecting objects.

BoilerPlate Space Definition (BPSD) tags
DocuMerge uses BPSD tags to recognize variable
data placement in a document.

button
An area on the screen that responds when you click
on it.  For example, each dialog box has an [OK] but-
ton that accepts your entries when you click on it.

centralized printer 
Also called production printer.  A classification of
large, high speed Xerox printers.  Examples of cen-
tralized printers are the 4050, 4650, 4090, 4850, 4890,
8700, 8790, 9700, and 9790.  See also distributed
printers.

click, on an item 
To momentarily press and release the left mouse but-
ton with the screen pointer on an item.

close 
To exit from a window, dialog box, or the Desktop.

close box 
A small white box at the left of a window header and
at the left of the menu bar.  Clicking a close box on a
window header closes the window.  Clicking a close
box on the menu bar exits the Desktop.
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command button 
A button in a dialog box that confirms or cancels an
action when you click on it.  The [Cancel] button can-
cels the command.  The [OK] button confirms and
executes the command and saves the information you
specified in a dialog box.

Converter icon 
The icon that converts font, form, graphics, and docu-
ment files.

cursor 
An I-shaped screen pointer used when entering text in
a dialog box.

Desktop 
The ElixiSys Desktop working environment, consisting
of the menu bar, the screen area, and the icons on the
screen.

dialog box
A rectangular box that displays and requests informa-
tion.  You enter information in fields in the dialog box,
and normally confirm your entries by clicking on an
[OK] button or by pressing <Enter>.

dimmed/grayed options 
Dimmed options are menu options you cannot choose
because they do not apply to your current selection.
Also called grayed options.

directory 
A list of hard disk or diskette contents.  Folder icons
represent Desktop directories.  You can view folder
contents pictorially, alphabetically, by icon, by size, or
by date.

Dispatcher icon 
The icon that stores and invokes a number of DOS
commands.

distributed printers
A classification of Xerox printers that are smaller and
slower than Xerox production (also known as central-
ized) printers.  Examples of distributed printers are the
2700, 3700, 4045, and 4700.  
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DocuMerge
An Image Sciences product that provides sophisti-
cated variable data merging and document assembly
capabilities to mainframe/host environments.

DOS  
Disk Operating System, the collection of programs
that gives control of a PC's resources to the user.

double-click 
To press the left mouse button twice in rapid succes-
sion, normally to open an icon.

drag
To click on an item and move the item with the mouse
while holding down the left mouse button.

drag and drop 
Used to copy an object as follows: click on an item on
the screen, hold down the left mouse button, move the
mouse to move the screen pointer to an icon, and re-
lease the mouse button.

drop 
To release the mouse button after dragging an item to
an icon.

EDL
See Electronic Document Library (EDL)

Electronic Document Library (EDL)
The DocuMerge utility that stores single- or multi-page
forms in composed format.

Elixir folders  
The folders represented by the four top left icons on
the Desktop: the Forms, Fonts, Graphics, and Docu-
ments folders.  Each of these folders contains an
Elixir, Input, and Output folder.

extension 
The three characters following the period after a file
name.  In the Desktop, an extension identifies the type
of information in a file.  For example, .ELX indicates
an Elixir format form file.

fast keys
See Keyboard Shortcuts.

GLOSSARY
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file name 
The name of a file.  The Elixir Desktop uses DOS file
naming conventions.  DOS file names consist of a
base (stem) name containing up to eight characters
and an extension of up to three characters.  Xerox
centralized printer file names consist of a stem name
of up to six characters and an extension of up to three
characters.

folder icon 
The Desktop icon representing a DOS directory.
Folders allow you to quickly organize information on
the Desktop.

form list file
A form list (.DAT) is an ASCII file that contains a list of
Elixir form file names (.ELX files) and commands that
control how specific forms print.

format 
To prepare a diskette so it can hold information.  For-
matting a diskette erases the information on the
diskette.

generic Elixir format 
The DOS file format an Elixir application uses (such
as ElixiFont, ElixiGraphics, and ElixiForm).

grayed/dimmed options 
Grayed options are menu options you cannot choose
because they do not apply to your current selection.
Also called grayed options.

highlighted 
A highlighted icon indicates a selected icon.

icon 
A small symbol that represents an application, a file, a
folder, or a peripheral device.

importing files 
The process of copying non-Elixir format files from dif-
ferent storage media (such as the hard disk, a disk-
ette, or tape) to the appropriate Desktop input folder.

inverse landscape/portrait 
The orientation of fonts, logos, or images on a page.
See the definition for portrait for a figure describing
the orientation of fonts on pages.  See figure G-1.
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Figure G-1.  Orientation of fonts on a Portrait (left)
and a Landscape (right) page

invoke 
To start an application.  Also referred to as run .

kerning
The technique of changing the printed space between
characters from the normal spacing.  Overlapping
characters create the effect.

keyboard shortcut 
Also called a Fast Key.  A one- or two-key combina-
tion that allows you to execute an option without using
the mouse.  Keyboard shortcuts display on each
menu beside the name of the option.

landscape
The orientation of a page or the fonts, logos, or im-
ages on a page.  A landscape page is narrower on the
sides than on the top.  See figure G-1.

menu 
A list of options from which you make a selection to
perform an action.  A menu displays when you select
a menu title from the menu bar or from a window
header.

menu bar 
The horizontal bar displayed at the top of the Desktop
from which you access pull-down menus.
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menu titles 
Text that identifies a menu, displayed in a window
header or on the menu bar.

message area 
A bar just below the menu bar that displays error mes-
sages or information about the activity you are
performing.

metacode 
The 9700 printer series Xerox-format print stream.

mouse button 
A button on top of the mouse.  The Elixir Desktop sup-
ports most actions using the left mouse button. Use
the right button to display icon properties or Help.

multi-select 
Selecting more than one file or icon by shift-clicking
on them.

open a folder, Elixir file, application, or peripheral
device:
1.) Opening a folder icon displays a window showing
the contents of the folder.  2.) Opening an Elixir file
icon starts the application that created the file and
loads the file .  3.) Opening an application icon starts
the application.  4.) Opening a peripheral device dis-
plays a properties dialog box allowing you to set the
device parameters.

option 
A word or phrase in a menu that you can select.

peripheral (device) 
A printer, scanner, diskette drive or tape drive con-
nected to your PC.

point 
To move the mouse so the screen pointer (in most
cases an arrow) rests on the desired item.

portrait  
The orientation of a page or the fonts, logos, or im-
ages on a page.  A portrait page is narrower on top
than on the side (like pages in this book).  See figure
G-1.

GLOSSARY

GLOSSARY-6 ELIXIR TECHNOLOGIES CORPORATION



Printers icon
The icon representing a proof printer connected to
your PC.

production printer
Also called centralized printer.  A classification of
large, high speed Xerox printers.  Examples of cen-
tralized printers are the 4050, 4650, 4090, 4850, 4890,
8700, 8790, 9700, and 9790.  See also distributed
printers.

pull-down menu 
See menu.

replaceable parameter
A parameter (usually %1) used in DOS commands to
represent a selected file name.  The selected file
name replaces the parameter during certain
operations.

run 
To execute or start an application.  Also referred to as
invoke.

Scanners icon  
The icon representing a scanner connected to your
PC.

screen pointer 
A pointer shaped like an arrow that displays on the
screen, and which you can move by rolling the mouse
on a flat surface.

scroll 
To move a directory list in a window so you can view
different parts of the list.

scroll bar 
A bar displayed on the right side of some windows
used for scrolling.  The scroll bar contains a scroll ar-
row, + and - buttons, and a slider bar that moves
within the scroll box.

select 
To click on an object or menu option.  A selected item
appears highlighted.
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shift-click 
To click on an object while holding down the <Shift>
key.  Usually used to select multiple items.

slider bar 
A bar in the scroll box at the side of some windows
that scrolls items in the window when you drag it up
and down.

Tape icon
The icon representing a tape drive connected to your
PC.

Trashbin icon
The trashbin icon is in the lower right corner of the
Desktop and represents a receptacle for items you
want to delete.  You delete a file by dragging it to the
trashbin icon.

UDK
(User Defined Key) a substitute escape character de-
fined by a user for specific print jobs.  See also XES.

unselect/deselect 
To cause one or more selected (highlighted) icons to
not be selected any more.  The quickest way to do this
is to click on another area of the Desktop.

UserTools icon 
The icon that links applications to files.

utilities 
Special-purpose applications with which you can per-
form functions from the DOS prompt.  For example,
the ELIXIDISK utility allows you to read, write, and for-
mat Xerox printer format diskettes.

wildcard character 
A character in a file name, usually an asterisk (*), that
specifies a matching set.  For example, *.FNT repre-
sents all files that end with the .FNT extension.

window 
A rectangular area on your screen in which you view
information, such the contents of a folder.  All win-
dows contain a window header.  Some windows have
scroll bars along the right side.
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window header 
The top of a window that displays the DOS directory
corresponding to the window contents.  Some window
headers also show a close box and a number of menu
titles with pull-down menus.

WYSIWYG
What you see is what you get

Xerox-labeled files
Files containing 128-byte or 512-byte Xerox headers,
or labels.

XES 
(Xerox Escape Sequence) a Xerox printer command
language recognized by Xerox distributed printers
(such as 2700, 3700, 4045, 4235, and 4700).

GLOSSARY

ELIXIR DOCUTAG USER GUIDE GLOSSARY-9



A
Acrobat Reader, docu-
mentation, 1-13
Adobe Type Manager
(ATM) fonts, 3-7
align, 3-6, 4-8
ASCII to EBCDIC trans-
lation, 7-4
ATM fonts, 3-7
AUTOEXEC.BAT, 2-2

B
Bitstream Fontware, 5-5
BPSD attributes

ElixiForm, 4-2
ElixiTag, 3-2
external font file,
3-13, 4-18, 6-8
external tag file,
3-12, 4-17, 5-4, 6-4
specifying in Ven-
tura, 5-6
specifying with
HP2XRX, 6-5

BPSD tags
changing, 3-3, 4-11
copying, 3-7, 4-12
deleting, 3-6, 4-10
editing, 3-7, 3-18,
4-10
external font file,
3-13, 4-18, 6-8
external tag file,
3-12, 4-17, 5-4, 6-4
form group, 4-26

frequently used,
4-25
icon/option, 4-4
limitations, 3-18
moving, 4-11
overview, 1-1
tag position marker,
3-13, 4-17, 5-4,
5-10, 6-10
use by DocuMerge,
1-1
using ElixiForm, 4-2
using ElixiTag, 3-2
using Ventura Pub-
lisher, 5-5

Bubble Help, 1-12
BWCC.DLL, 1-18

C
cautions

BWCC.DLL file,
1-18
multi-page support,
1-20
previous versions,
1-19
TAP2DSK, 1-19
text block integrity,
1-19

Clipboard, 3-7
CONFIG.SYS, 2-2
configuration

AUTOEXEC.BAT,
2-2
CONFIG.SYS, 2-2
tape drive, 2-2
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Context sensitive Help,
1-12
conventions

display, 1-9
file naming, 5-3, 6-3,
8-8, 8-11
mouse, 1-10
typographical, 1-9

Converter icon, 4-16
creating

a .DAT file, 4-13
a .NOR file, 3-8,
3-16
a print file, 3-16
normalized meta-
code, 3-8, 4-16
tags/ElixiForm, 4-2
tags/ElixiTag, 3-3
tags/HP2XRX, 6-5
tags/Ventura Pub-
lisher, 5-5

customer support, 1-6

D
Data Tagging dialog
box, 4-5, 4-25
data tags

external tag file, 4-3
icon/option, 4-4, 4-5,
4-25
tag position marker,
4-3

dataset partitioning
OUTPUT DD, 8-4
SYSUT1 DD, 7-2
SYSUT2 DD, 7-3,
8-5

default installation
first time, 2-11

delete after use, 3-5,
4-7, 4-22
Desktop

installation, 2-9
Dialog box Help, 1-12
directories

print file, 3-11
set documents, 4-20

set fonts, 4-20
DJDE prefix, 4-21, 5-8,
6-8
Document Converter
Options, 4-16, 5-7, 6-6
documentation

accessing, 1-13
Acrobat Reader,
1-13
directory, 1-13
navigating, 1-15
printing, 1-17
scrolling, 1-16
using, 1-13
word find, 1-15
zoom in/out, 1-16

DocuMerge
downloading library,
8-2
overview, 1-1
VLMMAINT, 7-5, 7-7
VLMUTIL, 7-5, 7-7

DocuTag
and ElixiForm, 4-1
and Elixir Print-
Driver, 3-1
and ElixiTag, 3-2
and HP2XRX, 6-2
and VP297, 5-1
cautions, 1-18
converter options,
3-12, 4-16, 4-17,
5-7, 6-6
features, 1-2
overview, 1-1

DocuTag Converter Op-
tions dialog box, 3-12,
4-16
DocuTag Extended Con-
verter Options dialog
box, 4-20
DOS

commands, 8-8, 8-9,
A-1

downloading fonts, 8-3,
A-1
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E
EDL, 1-1, 7-2, 8-2, 8-4
ElixiForm

adding tags, 4-2,
5-6, 6-6
BPSD tag icon, 4-4
changing tags, 4-11
copying tags, 4-12
creating a .DAT file,
4-13
deleting tags, 4-10
editing tags, 4-10
editing text caution,
1-19
introduction, 1-3
moving tags, 4-11
multi-page support,
1-20
soft keyboard, 4-9
starting, 4-3
Text toolbox, 4-4
Toolbar, 4-4
Toolbox, 4-3
using HP2XRX, 6-6
using MET2ELX,
8-12
using VP297, 5-6
viewing EDL mem-
bers, 8-16
workflow, 4-1

ElixiForm DocuTag
options

Comment, 4-6
Delete After Use,
4-7, 4-22
DJDE Prefix, 4-21
Elixir Documents in,
4-20
External Font File,
4-18
Field End Character,
4-6, 4-21
Field Gen, 4-6, 4-23
Field Length, 4-6
Field Name, 4-5

Field Number, 4-5
File Generation,
4-22
Image Compres-
sion, 4-19
JDE String, 4-18
JDL String, 4-18
Mandatory/Optional,
4-7
Multi-Data, 4-7, 4-22
NorMeta, 4-16
Offset, 4-21
Output to, 4-19
Page Bottom
Marker, 4-18
Replacement Char-
acters, 4-6, 4-21
Report End String,
4-23
Screen Fonts in,
4-20
Skip, 4-21
Tag Align, 4-8
Tag attrbute file,
4-17
Tag Field Depth, 4-6
Text Justification,
4-19
X-Shift, 4-21
Y-Shift, 4-22

Elixir applications
conventions, 1-8
Help, 1-11

Elixir Exec dialog box,
4-24, 5-10, 6-9
Elixir format fonts, 3-7,
8-2, A-1
Elixir Web site support,
1-7
ElixiTag

Add New Tag, 3-6
Copy, 3-7
Delete Tag, 3-6
dialog box, 3-2
File menu, 3-3
Help menu, 3-3
limitations, 3-18
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Scroll by Number,
3-6
Search by Name,
3-4
workflow, 3-1

ElixiTag options
Align, 3-6
Comment, 3-6
Delete After Use,
3-5
Depth, 3-6
Field End, 3-5
Field Gen, 3-6
Length, 3-4
Mandatory/Optional,
3-5
Multi-Data, 3-5
Name, 3-4
Number, 3-4
Replacement Char,
3-4

error and warning mes-
sages, 3-15, 4-24, 5-10,
6-10
external font file, 3-13,
4-18, 6-8
external tag file, 3-12,
4-3, 4-17, 5-4, 6-4
extract JCL for VLAM2,
8-5
extracting files

using a 3270 pack-
age, 8-4
using IRMA
FT/TSO, 8-9
workflow, 8-1

F
FBM format, 8-2
field end character, 3-5,
4-6, 4-21
field gen, 3-6, 4-6, 4-23
field length, 3-4, 4-6
field name, 3-4, 4-5
field number, 3-4, 4-5
file generation, 4-22
File menu, ElixiTag, 3-3

file transfer packages,
7-2, 8-2, A-1
files

.C00, 5-3

.DAT, 4-13

.ELX, 4-13, 4-14,
8-2, 8-12
.FRM, 8-3, 8-13
.HP, 6-2, 6-6
.IMG, 3-7, 6-4, 6-8
.LGO, 3-7, 8-3
.NOR, 3-8, 3-16
AUTOEXEC.BAT,
2-2
BWCC.DLL, 1-18
CONFIG.SYS, 2-2
converting Ventura
Publisher, 5-2
external font file,
3-13, 4-18, 6-8
external tag file,
3-12, 4-3, 4-17, 5-4,
6-4
extracting from host,
8-3, 8-4, A-1
graphics, 3-7, 5-4,
6-4
MET2ELX conver-
sion example, 8-14
naming conventions,
5-3, 6-3, 8-8, 8-11
print file, 3-16
re-naming during
conversion, 8-8,
8-11
saving, 4-8
Store Font, 8-3
transferring to host,
7-1, 7-2, A-1

fixed-blocked format,
7-5, 7-6, 8-3, 8-10
folders

Documents, 4-13
font file transfer, 8-3, A-1
Font Generation Prompt,
3-16
fonts
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ATM, 3-7
Bitstream Fontware,
5-5
DOS commands,
A-1
downloading from
host, 8-3, A-1
Elixir format, 3-7,
8-2, A-1
external font file,
3-13, 4-18, 6-8
GEM to Windows,
1-19
HP2XRX, 6-5
importing, 3-7, A-1
mapping, B-1
PrintDriver support,
B-1
regenerate fonts op-
tion, 3-11
screen, 4-20
transferring, 8-2, A-1
TrueType, 3-7
Ventura, 5-5
Xerox format, 3-7,
8-3

form group of frequently
used tags, 4-26
form list generation,
8-16
frequently used tags,
4-25
FT/3270 transfer specifi-
cations, 7-4, 8-4, A-1
FT/TSO transfer specifi-
cations, 7-4, 8-9, A-2

G
GEM to Windows, fonts,
1-19
graphics

.IMG, 3-7, 6-4

.LGO, 3-7, 8-3
converting, 3-7, 5-4,
6-4

HP2XRX
conversion, 6-4
VP297 conversion,
5-4

H
hardware, 2-1
Help, on-line, 1-11
Help hypergraphics,
1-13
Help menu, 1-12
Help menu, ElixiTag, 3-3
Help pop-ups and
jumps, 1-12
horizontal shift, 3-14,
4-21, 5-8, 6-8
HP2XRX, 1-4, 6-1, B-1

Converter Options
dialog box, 6-7
converting to Elixir
form, 6-6
workflow, 6-1

HP2XRX DocuTag
options

Clean Up Files, 6-8
Color Output, 6-9
Compress IMG
Graphics as, 6-8
Copies, 6-8
DJDE Entry, 6-8
External HP Font
file, 6-8
Format Graphics as,
6-8
Output Pages as,
6-8
Output to, 6-8
X and Y shift, 6-8

I
IBM/IRMA 3270 transfer
specifications, 7-4, 8-4,
A-1
IEBCOPY
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conversion to U-
format, 8-7
reformatting step,
8-5

IEBGENER, 7-3, 7-5
image compression,
4-19, 5-9, 6-8
image files, 3-7, 5-4, 6-4
importing fonts, 3-7, A-1
installation

custom, 2-12
default, 2-11, 2-12
first time installation,
2-10

IRMA FT/TSO transfer
specifications, 7-3, 8-9,
A-2

J
JCL

OUTPUT DD, 8-10
SYSUT1, 8-8, 8-10
SYSUT2, 8-8, 8-10
VLAM2, 8-5

JDE string, 3-13, 4-18
JDL string, 3-13, 4-18
Job ID, 3-9, 3-11
Job Print Ticket, 3-9

K
kerning table, 5-5, 6-5

L
licensing software, 2-4
limitations and consid-
erations, 3-18

M
Main Setup, PrintDriver,
3-8
mandatory/optional, 3-5,
4-7
mapping fonts, B-1
MET2ELX, 8-2, 8-11

MET2ELX file conver-
sion example, 8-14
mouse, 1-10
multi-data, 3-5, 4-7, 4-22
MVS host, 7-1

N
Non-MVS environments,
7-6
normalized metacode

converting, 8-4
extracting from host,
8-4
file format, 7-6
file naming, 8-8,
8-11
generating, 4-16
transferring to host,
7-2

Notepad, 4-15

O
offset, 4-21
on-line documentation

accessing, 1-13
Acrobat Reader,
1-13
directory, 1-13
navigating, 1-15
printing, 1-17
scrolling, 1-16
using, 1-13
zoom in/out, 1-16

OUTPUT DD dataset
partitioning, 8-4, 8-9
overview of DocuTag,
1-1

P
page bottom marker,
3-14, 4-18
planning the job, 1-5
pre-allocating
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OUTPUT DD, 8-4,
8-9
SYSUT1 DD, 7-2,
7-3
SYSUT2 DD, 7-3,
8-5, 8-9

pre-print options, 3-11,
3-16
PrintDriver

fonts, 3-7, B-1
graphics, 3-7
setting defaults, 3-8
setup, 3-8
work flow, 3-1

PrintDriver options
DocuTag options,
3-11
External Font File,
3-13
JDE string, 3-13
JDL string, 3-13
Job ID, 3-9
Job Print Ticket, 3-9
Page Bottom
Marker, 3-14
Pre-Print Options,
3-11
pre-print options,
3-16
Regenerate fonts,
3-11
Report End String,
3-15
Tag attribute file,
3-12, 4-3
Text Justification,
3-14
X-Shift, 3-14
Y-Shift, 3-14

printing
documentation, 1-17

proof-printing, 4-16,
5-10, 6-10

Q
Quick Help, 1-12

R
regenerate fonts, 3-11
registering software, 2-4
Release notes, 2-4
replacement characters,
3-4, 4-6, 4-21
report end string, 3-15,
4-23
requirements

hardware, 2-1
software, 2-2

S
sample JCL, 7-5
save/save as

in ElixiForm, 4-8
in ElixiTag, 3-3

saving a form, 4-8
screen fonts, 4-20
setting PrintDriver de-
faults, 3-8
soft keyboard icon, 4-9
software registration, 2-4
support, customer, 1-6
Support, Web site, 1-7
supported Windows ap-
plications, 1-3
SYSUT1 DD dataset
partitioning, 7-2, 7-3
SYSUT2 DD dataset
partitioning, 7-3, 8-9

T
tag align, 3-6, 4-8
tag field depth, 3-6, 4-6
tag position marker,
3-13, 4-3, 4-17, 5-4,
5-10, 6-4, 6-5, 6-10
TAP2DSK, 1-19
tape drive configuration,
2-2
tape output, 4-19, 5-8,
6-8
Task planning, 1-5
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text justification, 3-14,
4-19
Text toolbox, 4-4
Toolbar, 4-3
Toolbox, 4-3
transfer specifications

3270, 7-4, A-1
FT/TSO, 7-4, A-2

transferring files
using IBM/IRMA
3270, 7-2, 8-4, A-1
using IRMA FT/3270
or IBM 3270, 8-8
using IRMA
FT/TSO, 7-3, 8-9,
8-10, A-2
workflow, 7-1, 8-1

TrueType fonts, 3-7

U
U-format, 8-2, 8-7, 8-8,
8-15
utilities

IEBCOPY, 8-5, 8-10
IEBGENER, 7-2, 7-5
MAKEKRN, 5-5
MET2ELX, 8-2,
8-11, 8-12
TAP2DSK, 1-19
VLMMAINT, 7-5, 8-4
VLMUTIL, 7-5

V
VB format conversion,
8-9
VBM format, 7-5
Ventura Publisher

and DocuTag, 5-2
BPSD tags, 5-5
converting files, 5-2
converting to Elixir
form, 5-6
fonts, 5-5

vertical shift, 3-14, 4-22,
5-8, 6-8

viewing and editing the
.DAT file, 4-15
VLAM library, 8-9
VLMMAINT, 7-5, 7-7,
8-4
VLMUTIL, 7-5, 7-7
VP297, 1-4, 5-1, B-1

Converters Options
dialog box, 5-7
font mapping, B-1
workflow, 5-1

VP297 DocuTag options
Clean Up Files, 5-9
Color Output, 5-9
Compress IMG
Graphics as, 5-9
Copies, 5-8
DJDE Entry, 5-8
Elixir Documents,
5-9
Format Graphics as,
5-9
Output Pages as,
5-8
Output to, 5-8
X and Y shifts, 5-8

W
warning messages,
3-15, 4-24, 5-10, 6-10
Windows

Notepad, 4-15
Windows applications

supported products,
1-3
tag position mark-
ers, 3-13, 4-3, 4-17,
5-5, 6-5

word find, 1-15
workflow

extracting from host,
8-1
transferring to host,
7-1
using ElixiForm, 4-1
using HP2XRX, 6-1
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using PrintDriver,
3-1
using VP297, 5-1

X
X - Shift, 3-14, 4-21, 6-8
Xerox format fonts, 3-7,
8-3
XWIN.log

installation, 2-10

Y
Y - Shift, 3-14, 4-22, 6-8

Z
zoom in/out, 1-16
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